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1. Introducción 
1.1. Introducción 
 

Desde la creación del automóvil hemos vivido una constante evolución y mejora de estos. 

Hemos visto un gran avance en todos los aspectos, por ejemplo, seguridad, confort, control, 

maniobrabilidad o potencia. Todo esto ha sido gracias al descubrimiento de nuevos materiales, 

pero también a los ensayos que han permitido la optimización de cada una de estas piezas. 

En sus comienzos, las mejoras del vehículo se hacían mediante ensayos empíricos que muchas 

veces eran consecuencia de fatídicos accidentes, ya que al carecer de tecnología eran las 

personas quien debían realizar las pruebas con su consecuente riesgo. 

Posteriormente, junto al avance de la tecnología, también avanzaba la seguridad y precisión de 

estos ensayos, lo que nos permitía seguir mejorando y avanzando tecnológicamente el 

automóvil. Con la llegada de los sensores y el uso de maniquís que simulaban el cuerpo de una 

persona humana pudimos observar un gran avance en el automóvil. Estos sensores nos 

permitían registrar el comportamiento de todos los elementos. Por ejemplo, nos permitía 

observar el comportamiento de la suspensión de un vehículo al someterla a algún tipo de 

estímulo como podría ser un bache. Además, el uso de maniquís nos ha permitido obtener 

grandes avances de seguridad reduciendo en gran porcentaje la probabilidad de muerte en un 

accidente de tráfico. 

Seguidamente, el automóvil, al igual que muchos otros sectores industriales, se ha visto 

beneficiado del “boom” informático. Gracias a este avance informático ha sido posible la 

creación de programas de simulación los cuales son capaces de reproducir el comportamiento 

de un vehículo de una forma muy similar a la realidad. Esto nos permite la reducción del coste 

de investigación, ya que los muchos de los ensayos realizados tiempos atrás eran ensayos 

destructivos o requerían la creación de una pieza de gran valor económico. 

Finalmente, en la actualidad podemos seguir observando los avances de la tecnología. Podemos 

ver como se están investigando nuevos materiales, carrocerías, motores, amortiguaciones, etc. 

que en un futuro cercano serán montando en nuestros automóviles, pero a la vez, serán 

obsoletos en poco tiempo ya que la tecnología relacionada con el automóvil no para de avanzar 

al tratarse de un objeto imprescindible en nuestra vida. 
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1.2. Objetivos del proyecto 
 

El presente proyecto consiste en la creación de un modelo del vehículo Fiat/Seat 600 en el 

programa Adams Car para su posterior estudio con las diferentes herramientas de simulación 

que nos facilita el programa.  

Con ello, se pretende estudiar el comportamiento del vehículo en diferentes entornos como 

pueden ser la aceleración, frenado, curva o cambios de rumbo bruscos. Esto nos permitirá 

conocer de forma aproximada el comportamiento del Fiat/Seat 600 sin necesidad de hacer una 

prueba con el vehículo real. 

Para la realización de este proyecto hemos decido ir creando en diferentes etapas cada uno de 

los componentes que nos permite crear el programa. Las etapas han sido las siguientes: 

 Recogida de información del vehículo y medidas necesarias para la creación de sus 

componentes en Adams Car. 

 Modelado de la suspensión delantera y dirección acoplada a esta que nos permite 

controlar el vehículo. 

 Modelado de la suspensión trasera y el diferencial que nos permite transmitir la fuerza 

del motor a las ruedas traseras para el avance del automóvil. 

 Modelado de las ruedas. 

 Modelado del chasis, donde hemos tenido en cuenta el peso del automóvil real y 

adaptado sus los momentos para adaptar el comportamiento a la realidad. 

 Modelado del motor, donde hemos ajustado su potencia y la relación que posee la 

transmisión del vehículo real. 

 Modelado del sistema de frenado. 

 Unión de todos los subsistemas modelizados y análisis del comportamiento del 

automóvil. 

Los resultados obtenidos nos permitirán aproximar el comportamiento de este vehículo, el cual 

ha sido muy importante para la historia de España. 

Por último, añadiremos el modelo a una biblioteca en la cual hay otros vehículos, lo cual 

permitirá a las personas interesadas en ello, la comparación del comportamiento de estos 

dependiendo del tipo de vehículo estudiado. 
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2. Historia del vehículo 
 

Rondaba el año 1955 cuando en el “Salón del Automóvil” de Ginebra se presentaba el sucesor 

del Fiat 500, es decir, el Fiat 600. Se trataba de un coche más amplio y con más potencia que 

su predecesor, el cual en Italia no tuvo tanto éxito como su modelo anterior. 

En aquellos tiempos, España comenzaba a avanzar económicamente y de ello era prueba el 

“Plan de Desarrollo” publicado en aquella época por el gobierno. Uno de los pilares 

fundamentales de este plan de desarrollo fue el Seat 600. Se trataba de una réplica del modelo 

italiano presentado en Ginebra, pero la gente decía que el modelo de Seat era mucho más 

resistente que el de Fiat.  

El primer modelo de Seat 600 fue producido en 1957 en Barcelona. En una España que 

comenzaba a levantarse económicamente tras la postguerra, la aparición del Seat 600 fue de 

gran impacto social y un gran cambio que permitió iniciar la motorización de la sociedad 

española. 

  

Fig.2.1 Fábrica de Seat situada en la Zona Franca de Barcelona. Ref. [1] 

 

Se trataba de un automóvil robusto que rondaba los 600kilos de peso y alcanzaba una velocidad 

máxima en recta de 90km/h. Su precio inicial fue de 60.000 pesetas y debías estar inscrito en 

una larga lista de espera para recibirlo. El impacto del Seat 600 en la sociedad española fue tal 

que la gente comenzó a apodarle “el ombligo” ya que casi todas las familias españolas tenían 

uno de estos coches.  

A la vez que evolucionaba el Seat 600 también fue ligada a él la evolución de la clase obrera 

española. Esto es uno de los motivos por los que se considera a este automóvil una de las piezas 

clave de la historia de España. 
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Por un lado, el Seat 600 evolucionaba de manera constante, sus motores aumentaban de 

cilindrada, se creaban nuevos modelos de 4 puertos, nuevos modelos descapotables o nuevos 

modelos más deportivos. También, aumentaban los extras posibles a añadir al automóvil o las 

diferentes formas de configurar su interior.  

Por otro lado, a la vez que evolucionaba el Seat 600, evolucionaba la clase obrera de la época. 

Los trabajadores de la fábrica de la Zona Franca de Barcelona empezaban a reclamar mayores 

derechos al gobierno de la época. Esto provocó conflictos con el gobierno de la época que llegó 

incluso a causar la muerte de algunos de los trabajadores de la fábrica. 

Finalmente, el último modelo de Seat 600 fue producido en agosto de 1973. Se trataba de un 

modelo de color blanco, y los trabajadores de la fábrica lo despidieron con una pancarta con la 

frase “Naciste príncipe y mueres Rey”. Esta última frase es un claro reflejo de lo que supuso este 

modelo para la sociedad española de la época. 
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3. Herramientas empleadas 
3.1. AutoDesk AutoCAD 2017 
 

AutoCAD es un software de dibujo asistido de modelos 2D y 3D. Su primer programa fue 

presentado en diciembre de 1982 y actualmente es el programa de dibujo asistido más usado 

en el mundo. Este programa es usado en muchos ámbitos de la vida profesional como pueden 

ser arquitectura, construcción, fabricación, industria o investigación. En el caso de la Ingeniería 

Mecánica el programa nos ayuda a la creación de planos de piezas, máquinas u otros derivados 

relacionados con las máquinas. 

En el caso de este trabajo final de grado, AutoCAD nos has permitido visualizar planos del 

Fiat/Seat 600, tanto modelos en 2D como en 3D. 

 

Fig.3.1 Modelo 3D del Fiat/Seat 600 en formato AutoCAD. Ref. [2] 

Además, hemos utilizado las diferentes herramientas que nos facilita el programa para crear 

archivos independientes que solo poseen el chasis y la llanta de la rueda. Esto nos permitirá 

posteriormente mejorar visualmente el modelo final. 

                                               

              Fig.3.2 Modelo 3D del casis del Fiat/Seat 600.                            Fig.3.3 Modelo 3D de la llanta del Fiat/Seat 600  
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3.2. SolidWorks Student Edition 2016 
 

SolidWorks es un programa informático que nos ayuda al diseño de sólidos ayudándose de la 

tecnología CAD y CAE. SolidWorks Corporation fue fundada en 1993 y actualmente pertenece a 

la empresa Dassault Systems. Se trata de una de las herramientas más usadas en el ámbito de 

la ingeniería, ya que nos permite reproducir de una forma exacta el comportamiento y 

geometría exacta de muchas piezas. 

En el caso de este trabajo de fin de grado, la herramienta SolidWorks nos ha permitido importar 

los archivos AutoCAD (.dwg) para convertirlos a un formato compatible con el programa MSC 

Adams Car (Parasolid). Además, nos ha permitido reescalar el chasis y la llanta ya que no estaban 

en las medidas reales. 

 

Fig.3.4 Modelo del chasis del Fiat/Seat 600 importado a SolidWorks. 

 

Finalmente, la herramienta SolidWorks nos ha permitido abrir el motor de 4 cilindros en línea 

que poseía el Fiat/Seat 600 y adaptar en orientación al modelo del Adams Car. 

 

Fig.3.5 Motor 4 cilindros en línea. Ref. [3] 
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3.3. MSC Adams Car 
 

MSC Adams Car nos permite construir y probar rápidamente prototipos virtuales de vehículos 

completos y subsistemas de estos. El programa nos permite realizar diferentes ensayos con 

varias condiciones, carreteras, etc. Gracias a MSC Adams Car podemos permite simular ensayos 

que normalmente se realizan a los vehículos reales, pero en un periodo de tiempo muy corto y 

sin un alto coste económico como sería un ensayo destructivo. 

Algunas de las opciones que nos permite esta herramienta son: 

 Análisis de maniobras en los diferentes subsistemas (suspensión, dirección o vehículo 

completo). 

 Creación o importación de modelos sólidos 3D. 

 Amplia biblioteca de articulaciones y restricciones que nos permite definir de forma muy 

similar a la realidad la conectividad de las piezas. 

 Refinamiento de modelos los cuales contienen piezas flexibles, por ejemplo, brazos de 

suspensión, neumáticos, etc. 

 Resultados completos, tanto lineales como no lineales, para diseños complejos. 

 

Nuestro trabajo de fin de grado ha sido posible gracias a las herramientas nombradas 

anteriormente. En el caso de MSC Adams Car, nos ha permitido la simulación de las 

suspensiones, la dirección y el vehículo completo. Además, nos ha permitido analizar mediante 

gráficas los diferentes resultados obtenidos en los ensayos. 

 

 

Fig.3.6 Ejemplo de un modelo realizado mediante la herramienta MSC Adams Car. Ref. [4] 
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4. Datos de partida 
4.1. Origen de datos 

 

Las medidas del Seat 600 y sus componentes han sido obtenidas de manuales oficiales 

encontrados en la Web. Se tratan de manuales escaneados en formato PDF los cuales proceden 

de la fábrica oficial de Seat. (Anexo I) 

Gracias al manual citado, hemos obtenido el peso total del vehículo, pero no el de cada uno de 

los subsistemas que compone este. Por lo que hemos optado por realizar una aproximación que 

nos permita acercar el comportamiento del vehículo a la realidad. 

Al igual que con los pesos de los subsistemas, no nos has sido posible encontrar detalladamente 

las medidas de la suspensión del Seat 600, por lo tanto, nos hemos ayudado de los planos 

oficiales (Anexo I) y las medidas realizadas a un modelo real. 

Además, no nos ha sido posible obtener datos exactos de los neumáticos, momentos de inercia, 

etc. por lo que lo hemos tratado de acercarnos al comportamiento de estos con una serie de 

cálculo aproximativos. 

Debido a todo esto, el comportamiento de nuestro modelo en MSC Adams Car no será 

exactamente igual al que tendría un modelo real de Seat 600. Pero si conseguiremos un 

comportamiento parecido que nos permitiría mejorar algunas características del automóvil. 
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5. Modelado del Fiat/Seat 600 
5.1. Introducción 
Este trabajo de fin de grado consistirá en el modelado del vehículo Fiat/Seat 600 en el programa 

MSC Adams Car. Para ello, hemos partido de un modelo real el cual hemos adaptado de forma 

aproximada en el programa. Podemos observar la comparación de ambos modelos en las 

siguientes figuras: 

  

Fig.5.1. Modelo real del vehículo Seat 600. Ref. [5]             Fig.5.2. Modelo realizado en Adams Car. 

Partiendo de los datos obtenidos sobre el automóvil hemos realizado una modificación de los 

archivos que nos proporcionaba el programa MSC Adams Car adaptándolos a nuestro modelo. 

Con la herramienta “Template Builder” hemos creado los modelos necesarios para 

funcionamiento del coche, y posteriormente, en el modo “Standard Interface” hemos creado 

los subsistemas. 

Finalmente, con todos los subsistemas necesarios ya creados, hemos unido todo el vehículo con 

la herramienta “Full-Vehicle Assembly”. Con esto, ya hemos podido realizar las pruebas del 

vehículo completo y comprobar su correcto funcionamiento. 

 

 

 

5.2. Modelado de la carrocería 
 

5.2.1. Introducción 
 

La carrocería es una de las partes más importantes del vehículo. Se trata del lugar del vehículo 

donde viajan los pasajeros y la carga, por ello, es uno de los elementos que ha sufrido mayor 

cambio en los últimos tiempos, ya que de él depende en gran medida la seguridad de los 

pasajeros. 

A la hora de clasificar un vehículo es muy importante su carrocería. Podemos encontrar diversas 

clasificaciones, pero una de las más usadas es la basada en el volumen de la carrocería.  

Por un lado, podemos encontrar las carrocerías monovolumen. Son aquellas carrocerías en las 

que no sería posible diferenciar más de un volumen, ya que la zona motor la cabina y el maletero 
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están integrados en partes no diferenciables. Normalmente, este tipo de vehículos son amplios 

y más alto que un turismo normal.  

 

Fig.5.3 Modelo del monovolumen “Seat Alhambra 2016”. Ref. [6] 

Por otro lado, podemos encontrar las carrocerías que reciben el nombre de “dos volúmenes”. 

Se trata de aquellas carrocerías en las que podemos observar dos partes claramente 

diferenciables. Normalmente, sus partes son el capo junto al motor y el habitáculo donde irían 

los pasajeros y la carga. Además, podemos encontrar modelos de todo tipo de tamaño (tres 

puertas, cinco puertas, etc.) 

 

Fig.5.4 Modelo “dos volúmenes” del Seat León cinco puertas 2016. Ref. [7] 

Finalmente, encontramos los modelos de tres volúmenes o también llamados tricuerpo. Como 

bien dice el nombre se tratan de vehículo con tres partes claramente diferenciadas. Sus partes 
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son el capo (donde normalmente encontramos el motor), el habitáculo (donde viajan los 

pasajeros) y el maletero (donde normalmente se guarda la carga).  

 

 

Fig.5.5 Modelo tricuerpo del Seat 124. Ref. [8] 

 

En el caso del vehículo estudiado en este trabajo, podemos observar claramente que se trata de 

un vehículo de “dos volúmenes”. Pero el Seat 600 tiene una particularidad respecto a los “dos 

volúmenes actuales”, su motor está situado en la parte trasera mientras que su parte delantera 

(capó) es usada para transportar la carga, como podemos observar en la figura 5.6. 

 

 

Fig.5.6 Parte delantera del Seat 600. Ref. [9] 
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5.2.2. Modelado 
 

Para la realización de la carrocería hemos decidido partir de un modelo CAD. En nuestro caso 

hemos encontrado un modelo con formato AutoCAD (Ref. [10]) el cual modificaremos. Al abrir 

el archivo observamos que consta de chasis y ruedas, por lo tanto, borraremos desde AutoCAD 

las ruedas y aquellas partes que no formen parte de la carrocería. 

Posteriormente, con el trabajo en AutoCAD ya realizado, procedemos a importar nuestro CAD a 

SolidWorks. Desde este programa procedemos a reescalar el vehículo aumentando su tamaño 

55 veces del CAD original, ya que buscamos las medidas reales del vehículo. Además, 

orientaremos el chasis de la forma correcta para que no tengamos ningún problema al 

importarlo al MSC Adams Car. Como último paso en SolidWorks, guardaremos el archivo en un 

formato que nos permita importar de forma correcta el chasis a MSC Adams Car, en este caso 

hemos optado por el formato ParaSolid (.x_t). 

Con el trabajo de CAD ya realizado podemos empezar a trabajar en MSC Adams Car. En primer 

lugar, abriendo el modo Template Builder, debemos asegurarnos que creamos una base de 

datos en la cual almacenaremos todos los archivos de nuestro modelo. En este caso, nosotros 

hemos decido usar la base de datos que nos trae por defecto Adams, por lo tanto, nuestros 

archivos se almacenaran en la carpeta Private.cdb. Con este paso ya realizado, podemos 

empezar a trabajar con nuestro modelo, debemos abrir el modelo por defecto que nos trae 

Adams Car (File>Open>Template Name>aca_shared>_rigid_chassis.tpl) y borrar todas aquellas 

piezas que pertenecen al chasis del Ferrari (Edit>Delete). Seguidamente, debemos importar el 

archivo ParaSolid del chasis del Seat 600, para ello vamos a File>Import, seleccionamos File 

Type>ParaSolid, en File to Read seleccionamos nuestro archivo CAD y cambiamos Model Name 

por Part Name, aquí seleccionamos que nuestro archivo pertenecerá a ges_chassis, 

introducimos su posición correcta y pulsamos OK.  

Con el chasis ya importado debemos realizar los dos últimos pasos en el modo Template Builder. 

En primer lugar, debemos colocar los Hardpoints en sus respectivos lugares, ya que ahora 

tenemos un chasis diferente, por lo que los colocaremos de la siguiente forma. 

 

 

Fig.5.7 Posición de los Hardpoints en el chasis del Seat 600. 
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En segundo lugar, y como paso final en el modo Template Builder, debemos guardar el archivo 

final (Figura 5.8). Para ello, iremos a File>Save as… y le daremos el nombre de ChasisFinal600. 

 

Fig.5.8 Archivo _ChasisFinal600 

Con la plantilla ya creada, debemos cambiar ahora al modo Standard Interface para crear el 

subsistema ligado a esta plantilla. Para ello, dentro del modo Standard Interface, 

File>Subsystem, le asignamos el nombre de S600_Body y ponemos Minor Role>Any. Obtenemos 

el siguiente subsistema:  

 

Fig.5.9 Subsistema S600_Body.sub 
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El siguiente paso será asignar los momentos de inercia y el peso que corresponde a la carrocería 

del Seat 600, ya que tendremos los valores que asigna el programa a la carrocería anterior. Para 

ello, y dado que no tenemos los datos necesarios, hemos optado por realizar un modelo 

aproximado suponiendo que el coche es un cubo al cual asignamos peso del coche, lo que nos 

permitirá calcular los momentos de inercia. 

 

Fig.5.10 Cubo supuesto para el cálculo de inercias 

 

Donde realizamos los siguientes cálculos: 

 

𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠 = 𝑃𝑒𝑠𝑜 𝑇𝑜𝑡𝑎𝑙 − 𝑃𝑒𝑠𝑜 𝑀𝑜𝑡𝑜𝑟 = 600 − 70 = 530 𝐾𝑔 

 

𝑎 = 3295𝑚𝑚   𝑏 = 𝐴𝑙𝑡𝑢𝑟𝑎 𝑡𝑜𝑡𝑎𝑙 − 𝑅𝑎𝑑𝑖𝑜 𝑅𝑢𝑒𝑑𝑎 = 1350 − 268 = 1082𝑚𝑚   𝑐 = 1380𝑚𝑚 

 

𝐼𝑥𝑥 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) =

1

12
530 (10822 + 13802) = 1.35818 ∗ 108𝐾𝑔𝑚𝑚2 

 

𝐼𝑦𝑦 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) =

1

12
530 (32952 + 10822) = 5.31226 ∗ 108𝐾𝑔𝑚𝑚2 

 

𝐼𝑧𝑧 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) =

1

12
530 (32952 + 13802) = 5.636306 ∗ 108𝐾𝑔𝑚𝑚2 

 

 

 



 

15 
 

Modelado y simulación dinámica del automóvil Fiat/Seat 600 

Grado en Ingeniería Mecánica 

Ahora, debemos introducir los cálculos al subsistema, por lo que dentro de S600_Body.sub en el 

menú Browse pulsamos ges_chassis>Modify y modificamos los valores en las casillas 

correspondientes. 

 

 

Fig.5.11 Modify General Part del subsistema S600_Body 

Finalmente, ya tendremos el chasis con todos los datos necesarios para la simulación por lo que 

procederemos a guardarlo, para ello vamos a File>Save. Con esto, finalizamos el modelado del 

chasis. 

 

 

 

 

 

 

 

 

 



 

16 
 

Modelado y simulación dinámica del automóvil Fiat/Seat 600 

Grado en Ingeniería Mecánica 

5.3. Modelado de la suspensión delantera 
 

5.3.1. Introducción 
 

La suspensión de un vehículo es el conjunto de brazos, muelles, amortiguadores, etc. que nos 

permite unir las masas suspendidas del vehículo con las no suspendidas (en las cuales están 

incluidas las suspensiones). El sistema de suspensiones nos permite mantener el contacto de la 

rueda con la carretera ayudándonos a mantener el control del vehículo en diversas situaciones, 

por ello, es una de las partes más importantes en el mundo de la ingeniería automovilística.  

Respecto a los tipos de suspensiones, podemos encontrarlas de muchos tipos y formas. En el 

caso de nuestro vehículo, la suspensión utilizada es la conocida como suspensión de doble brazo 

(double wishbone suspension). Esta suspensión basa su funcionamiento en dos brazos, los cuales 

normalmente son paralelos, los cuales oscilan para mantener la rueda siempre en contacto con 

la calzada. Además, consta de un amortiguador y un resorte el cual nos permite controlar el 

movimiento vertical de la suspensión. 

Como es común, el montaje de la suspensión consta de el anclaje de los brazos al chasis. Ambas 

finalizaciones de cada uno de los brazos se unen al chasis mediante pares de revolución. 

Respecto al muelle y amortiguador, se encuentran unidos al chasis y permiten un movimiento 

vertical total sin interceder en los brazos. 

 

Fig.5.12 Suspensión delantera del Seat 600. Ref. [11] 
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5.3.2. Modelado 
 

Para el modelado de la suspensión delantera hemos partido de los planos de la suspensión 

facilitados en el “Manual Oficial” del Seat 600 y las medidas tomadas al vehículo real. Analizando 

los datos de esta tomamos la decisión de partir de un modelo ya creado en la base de datos de 

Adams Car. 

En primer lugar, abrimos Adams Car en su interfaz Template Builder. Seguidamente, abrimos el 

modelo base seleccionado, para ello File>Open>acar_shared>templates.tbl y seleccionamos la 

suspensión Double Wishbone. 

 

 

Fig.5.13 Suspensión Double Wishbone facilitada por Adams Car. 

 

En segundo lugar, dado que la suspensión delantera de nuestro vehículo no es motriz 

procederemos a desactivar el diferencial. Para este paso, iremos al menú Browse, 

seleccionaremos Parts>General Parts y borraremos las partes correspondientes al diferencial 

(ger(l)_tripot y ger(l)_drive_shaft).  

 

Seguidamente, deberemos crear una geometría igual a la de los brazos, muelle y amortiguador 

del modelo original, por lo tanto, modificamos los Hardpoints según los datos geométricos 

obtenidos de la suspensión. 
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Fig.5.14 Hardpoints pertenecientes a la suspensión delantera del Fiat/Seat 600. 

El siguiente paso será modificar los amortiguadores y muelles para el correcto funcionamiento 

de la suspensión. Para ello, debemos ir a la base de datos del Adams Car 

MSC.Software>Adams>2017_1>acar>shared_car_database.cdb y copiar los datos de muelles 

(springs.tbl) y amortiguadores (dampers.tbl) a nuestra base de datos, en mi caso, private.cdb. A 

continuación, abriremos nuestra base de datos y en las carpetas copiadas anteriormente 

cambiaremos el nombre de los archivos mdi_0001.spr por Front_Susp_600.spr y mdi_0001.dpr 

por Front_Suspension_600.dpr. Ahora debemos hacer que nuestra suspensión funcione 

respecto a estos archivos por lo que en el menú Modify del muelle y del amortiguador usamos 

como Property File los archivos de nuestra base de datos. 

 

 

Fig.5.15 Ejemplo de la modificación del amortiguador en el campo Property File. 
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Como último paso en la interfaz Template Builder, deberemos guardar el archivo en nuestra 

base de datos, por lo tanto, File>Save y lo llamaremos FIAT600_Front_Suspension. 

En este momento debemos cambiar a Standard Interface para crear el subsistema de la 

suspensión delantera. Para ello, debemos pulsar File>New>Subsystem, darle el nombre de 

S600_Front_Suspension, seleccionar Minor Role: Front y usar FIAT600_Front_Suspension.tbl. 

 

Fig.5.16. Subsistema S600_Front_Suspension 

 

Como paso final, debemos modificar los archivos del muelle y el amortiguados. Para ello, en el 

menú Modify Spring debemos seleccionar la opción de gráficos. 

 

 

Fig.5.17 Modify Spring menú 
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Se nos abrirá una ventana nueva, en esta ventana debemos pulsar View>Data Table y modificar 

los valores de la tabla según las fuerzas que actúan en la suspensión real del Seat 600. Si 

queremos observar los datos modificados en un gráfico podemos pulsar View>Plot y nos 

dibujará una gráfica con los datos del muelle. 

 

Fig.5.18 Gráfica de las fuerzas realizadas por el muelle en el archivo S600_Front_Suspension 

 

El archivo del amortiguador (Damper) se modificará de forma la misma forma acorde con los 

datos reales del vehículo. Finalmente, guardamos el archivo de la suspensión delantera pulsando 

File>Save. 
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5.4. Modelado de la suspensión trasera 
 

5.4.1. Introducción 
 

Como ya hemos dicho en el apartado anterior, la suspensión es uno de los subsistemas 

esenciales a la hora de entender el funcionamiento del vehículo. En este apartado nos vamos a 

centrar en la suspensión trasera del Fiat/Seat 600. 

La suspensión de brazo independiente (trailing arm) es una de las suspensiones más simples y 

económicas que podemos encontrar en el mercado. Se trata de uno o varios brazos anclados al 

chasis respecto a un eje que permite que pivoten en dirección vertical, para controlar el 

movimiento en esta dirección se usan muelles y amortiguadores.  

Este tipo de suspensiones suelen ser usadas en el eje trasero de los vehículos, pero no solo es 

usada en automóviles, también podemos encontrar ejemplos de esta suspensión en aviación u 

otras aplicaciones de la ingeniería. 

 

 

Fig.5.19 Plano de la suspensión trasera del Seat 600. Ref. [12] 
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5.4.2. Modelado 
 

Del mismo modo que en la suspensión delantera, para crear la suspensión trasera hemos partido 

de una plantilla facilitadas por Adams Car. Por lo que debemos abrir el modo Template Builder, 

pulsar File>Open>acar_shared>templates.tbl y seleccionaremos la suspensión TrailingArm. 

 

 

Fig.5.20 Suspensión Trailing Arm facilitada por Adams Car 

 

Al tratarse de un vehículo de tracción trasera no deberemos modificar el diferencial, por lo 

tanto, el siguiente paso será modificar la geometría para adaptarla al modelo real. Para ello, 

debemos modificar los Hardpoints y situarlos en las coordenadas correctas. 

 

Fig.5.21 Suspensión trasera tras modificar los Hardpoints 
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Fig.5.22 Hardpoints pertenecientes a la suspensión trasera del Fiat/Seat 600 

 

Del mismo modo que en la suspensión delantera, también debemos cambiar los archivos que 

asignan las propiedades a los muelles y amortiguadores. Realizaremos los pasos exactamente 

igual que en el apartado anterior cambiando los nombres mdi_0001.spr por Rear_Susp_600.spr 

y mdi_0001.dpr por Rear_Suspension_600.dpr. 

Con la geometría y las propiedades de la suspensión ya creadas, guardaremos el Template 

nombrándolo como S600_RearSuspensionFinal. Seguidamente, abriremos el modo Standard 

Interface y crearemos un nuevo subsistema. A este subsistema le llamaremos 

S600_Rear_Suspension, le asignaremos Minor Role: Rear y el Template creado anteriormente. 

También deberemos modificar los archivos de los muelles y amortiguadores como hemos 

explicado anteriormente (Modify Springs or Modify Dampers). En este caso, tendremos un 

muelle mucho más rígido ya que el peso a soportar por la suspensión trasera es mayor. 
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Fig.5.23 Gráfico de las fuerzas realizadas por el muelle en el archivo S600_Rear_Suspension 

 

Finalmente, al terminar la modificación de los muelles y amortiguadores, guardaremos el 

subsistema en nuestra base de datos (private.cdb). 
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5.5. Modelado del motor-transmisión 
 

5.5.1. Introducción 
 

Un motor es una máquina que permite transformar una energía en energía mecánica. En el caso 

de los automóviles podemos encontrar principalmente dos tipos de combustibles: gasolina 

(MEP) y diésel (MEC).  

En el caso del Fiat/Seat 600, poseía un motor de encendido provocado (MEP). Por lo que vamos 

a centrar esta introducción en este tipo de motores, ya que su funcionamiento es algo diferente 

a los motores de encendido por compresión (MEC). 

Este tipo de motor genera la energía mediante gasolina, para ello está debe ser “incendiada” 

mediante una chispa que produce la bugía. La energía creada por esta explosión permite al 

pistón moverse, y gracias al cigüeñal se transmite a un engranaje que transmite el movimiento 

al diferencial y las ruedas. 

Estos motores, al contrario de los encendidos por compresión, suelen tener una relación de 

compresión baja. Esta relación de compresión está limitada por la posibilidad de explosión de la 

gasolina y limita bastante el rendimiento de estos motores. 

En el caso del motor de nuestro vehículo, el motor poseía 4 cilindros en línea y en un principio 

tenía una capacidad de 600 cc3, pero a lo largo de su fabricación fueron mejorando hasta el 

punto de crear motores con capacidad de 800 cc3. 

 

5.5.2 Modelado 
 

Para el modelado del bloque motor de nuestro vehículo ha sido necesario obtener una serie de 

informaciones. La información obtenida han sido las curvas de motor, un CAD que nos permitirá 

mejorar gráficamente nuestro modelo, cantidad de marchas, relación de marchas y velocidad 

final. 

Con toda esta información obtenida podemos comenzar con el modelado del bloque motor. En 

primer lugar, abrimos el programa Adams Car en su modo Template Builder y abrimos el archivo 

del motor Ferrari (/acar_shared/templates.tbl/_powertrain.tpl) en el cual basaremos el nuestro. 

El siguiente paso será borrar toda la apariencia del motor del Ferrari para posteriormente añadir 

nuestro modelo de CAD. Para ello, pulsamos Edit>Delete y borramos todo lo que no sea 

necesario. 

Como primer paso, importaremos nuestro archivo de CAD. Pulsamos File>Import, seleccionamos 

en File Type: Parasolid, cargamos el modelo del motor de 4 cilindros en línea, cambiamos Model 

Name por Part Name y añadimos este a ges_powertrain en las coordenadas y orientación 

correctas. 
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Fig.5.24 Motor de 4 cilindro en línea exportado a Adams Car 

 

Con el Template ya creado debemos guardarlo en nuestra base de datos, File>Save y le daremos 

el nombre de S600_PowerTrain. 

El siguiente paso será cambiar el modo del Adams Car a Standard Interface para crear el 

subsistema ligado al Template. Con este modo abierto, pulsamos File>New>Subsystem, le 

damos el nombre de S600_Powertrain, Minor Role: Any y usamos el Template recién creado. 

A continuación, debemos modificar las propiedades del motor, ya que de serie viene con las 

propiedades del Ferrari (MDI_Example). Pulsamos Adjust>Powertrain Properties y vemos como 

se nos abre una nueva ventana. Dentro de esta, seleccionaremos la pestaña Transmission y 

modificaremos las marchas de acuerdo a la información del vehículo (Anexo I). 

 

 

Fig.5.25 Relación y cantidad de marchas del Fiat/Seat 600 
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Posteriormente, también debemos de modificar los parámetros de funcionamiento del motor 

por lo que ajustaremos su velocidad de giro, su velocidad de giro y las curvas de funcionamiento. 

Para la modificación de las curvas, hemos creado un nuevo archivo en nuestra base de datos 

(private.cdb) al cual hemos llamado S600_Curva_Motor.pwr. Tras la creación del archivo 

debemos añadirlo en Property File. Además, deberemos también modificar la inercia de giro que 

genera el motor al girar y sus límites en cuanto a revoluciones. 

 

Fig.5.26 Propiedades del motor Fiat/Seat 600 

 

Tras esto, abriremos con un editor de texto el archivo S600_Curva_Motor y modificaremos la 

tabla de potencia. Para ellos hemos partido de unas curvas aproximadas, estas tablas las hemos 

ido ajustando sabiendo que el Seat 600 era capaz de acelerar a 95km/h en un tiempo de 35 

segundos.  

Revoluciones 
Rpm) 

Par Resistente 
(Nm) 

Par Motor 
(Nm) 

500 -7541 17000 
1600 -7722 28000 
2000 -7735 37000 
2300 -7740 39000 
2500 -7760 40000 
3000 -7783 41000 
3300 -7813 40500 
3500 -7821 40000 
4000 -7838 39000 
4300 -7856 38000 
4500 -7874 37000 
5000 -7891 35000 
5300 -7909 33000 
5600 -7927 30000 
6000 -7945 25000 
6200 -7962 21000 
6350 -7980 18000 

 

Fig.5.27 Curvas del motor Fiat/Seat 600 ensayado en banco de pruebas 
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Continuamos pulsando el botón Power/Velocity Plot y se nos abrirá la siguiente ventana (Figura 

5.27) la cual nos permitirá analizar las curvas del motor y verificar que son correctas. 

 

Fig.5.28 Curvas motor del archivo S600_Powertrain 

 

Además, deberemos asignar un peso y unas inercias a nuestro motor. Dado que esta información 

no es facilitada por el fabricante, y al igual que con el chasis, hemos decidido intentar aproximar 

sus valores con una serie de cálculos. 

 

Fig.5.29 Cubo supuesto para los cálculos del motor 
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Donde realizamos los siguientes cálculos: 

 

𝑃𝑒𝑠𝑜 𝑀𝑜𝑡𝑜𝑟 = 70 𝐾𝑔 

 

𝑎 = 550𝑚𝑚   𝑏 = 520𝑚𝑚   𝑐 = 630𝑚𝑚 

 

𝐼𝑥𝑥 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) = 70(5202 + 6302) = 3.892583 ∗ 106𝐾𝑔𝑚𝑚2 

 

𝐼𝑦𝑦 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) =

1

12
70 (5502 + 5202) = 3.3419316 ∗ 106𝐾𝑔𝑚𝑚2 

 

𝐼𝑧𝑧 =
1

12
𝑃𝑒𝑠𝑜 𝐶ℎ𝑎𝑠𝑖𝑠(𝑏2 + 𝑐2) =

1

12
70 (5502 + 6302) = 4.079833 ∗ 106𝐾𝑔𝑚𝑚2 

 

Aunque gráficamente los lados del cubo no coincidan con las medidas dadas, se debe a que en 

el archivo CAD no se tienen en cuenta la transmisión y otros elementos pertenecientes al bloque 

motor. Las medidas usadas para la suposición han sido tomadas del modelo real para intentar 

aproximar de forma exacta el resultado. 

Finalmente, en el menú Modify General Part de la parte ges_powertrain asignaremos los valores 

calculados y guardaremos el subsistema acabando así con el modelado del bloque motor. 

 

Fig.5.30 Menú Modify General Part de la parte ges_powertrain 
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5.6. Modelado de la dirección 
 

5.6.1. Introducción 
 

La dirección es el conjunto de componentes, acoplamientos, etc. que nos permite que cualquier 

vehículo siga el camino deseado, es decir, el objetivo principal de la dirección es permitir que el 

conductor guíe el vehículo. 

En el caso de la suspensión de un automóvil, la dirección nos permite girar las ruedas directrices 

(normalmente delanteras) para elegir la trayectoria. Respecto a los tipos de dirección podemos 

encontrar muchos tipos: piñón cremallera, tornillo sinfín, asistidas, etc. 

En nuestro caso vamos a centrarnos en el funcionamiento de las direcciones tornillo sinfín ya 

que son las que nuestro vehículo usa, Su funcionamiento es muy simple, encontramos una caja 

en la que el volante engrana con un tornillo sin fin que al moverse permite el movimiento de las 

ruedas. 

 

Fig.5.31 Interior de la caja de una dirección de tornillo sinfín. Ref. [13] 

Como podemos observar en la siguiente figura (Figura 5.29) una barra una la caja de dirección 

con un brazo que es el que permitirá el movimiento de la rueda más alejada. 

 

Fig.5.32 Esquema de una suspensión basada en el sistema tornillo sinfín. Ref. [14] 

Se trata de una dirección con muchas partes móviles por lo que suelen tener un funcionamiento 

menos preciso que otras direcciones más simples como podría ser la dirección piñón cremallera. 
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5.6.2. Modelado 
 

A la hora de realizar el modelado de la dirección, la base de datos de Adams Car nos facilita un 

modelo de dirección tornillo sinfín (parallel_link_steering) en la cual basaremos nuestro modelo.  

En primer lugar, abrimos el modelo facilitado pulsando File>Open y seleccionándolo 

/acar_shared/templates.tbl/_parallel_link_steering.tpl. Tan solo debemos modificar los 

Hardpoints de acuerdo a los datos obtenidos sobre la dirección del Fiat/Seat 600. Tras hacer 

esto, guardaremos el Template con el nombre FIAT600_Steering. 

 

Fig.5.33 Hardpoints pertenecientes al archivo FIAT600_Steering 

En segundo lugar, cambiaremos al modo Standard Interface y crearemos un nuevo subsistema. 

Lo llamaremos S600_Steering, le asignaremos Minor Role: Front y como Template Name 

escogeremos los datos recientemente creados.  

Finalmente, guardaremos nuestro subsistema en nuestra base de datos (private.cdb). 

 

Fig.5.34 Imagen del subsistema S600_Steering 
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5.7. Modelado frenos 
 

5.7.1. Introducción 
 

Un freno es un dispositivo mecánico que trata de reducir el movimiento absorbiendo energía 

del sistema que se encuentra moviéndose. En el caso de los vehículos, se usa para ralentizarlo o 

detenerlo actuando sobre sus ruedas mediante fricción. 

Principalmente existen dos tipos de frenos: disco y tambor. 

Por un lado, los frenos de disco, como bien dice su nombre, basan su funcionamiento en un 

disco y una pinza que ejerce presión sobre este. El disco gira está enganchado a la rueda y gira 

con ella, cuando el usuario desea frenar activa el freno y una serie de resortes presionan las 

almohadillas que a su vez presionan el disco. La fricción creada por esta presión es la que disipa 

la energía y permite frenar al vehículo. 

 

 

Fig.5.35 Frenos de disco pertenecientes a un modelo de Seat 600. Ref. [15] 

 

Por otro lado, los frenos de tambor. Estos frenos también se basan en la fricción para disipar la 

energía, pero su funcionamiento es algo distinto al de los anteriores. La rueda posee un tambor 

que gira junto a ella, en el interior de este hay dos zapatas curvadas preparadas para soportar 

la fricción. Al accionar el freno, estas zapatas ejercen rozamiento sobre el tambor, lo que genera 

que la energía se disipe debido a la fricción y el vehículo se detenga. 
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Fig.5.36 Imagen detallada de unos frenos de tambor. Ref. [16] 

 

5.7.2. Modelado 
 

Para el modelado de los frenos debemos saber el tipo de freno que usa nuestro vehículo. El 

Fiat/Seat 600 en un principio usaba frenos de tambor, pero al no ser posible el uso de este tipo 

de freno, hemos creado unos frenos de disco equivalentes que nos permitan aproximar el 

comportamiento de los frenos reales. 

En primer lugar, debemos crear un subsistema de frenos que pertenezca a nuestro vehículo, por 

lo tanto, abrimos los frenos por defecto que nos trae el programa 

Open>Subsystem>acar_shared/subsystems.tbl/TR_Brake_System.sub. Tras abrir el archivo, 

guardamos (File>Save) otro idéntico, pero en este caso con el nombre S600_BrakeSystem. 

En segundo lugar, debemos abrir el subsistema creado (S600_BrakeSystem.sub) con un editor 

de texto. Al hacer esto, podemos observar una serie de parámetros que nos permitirá modificar 

y que son los que determinan el comportamiento del freno. 

Finalmente, modificamos estos parámetros para que el vehículo se comporte parecido a la vida 

real y guardamos el archivo de texto. 

 

Fig 5.37 Parámetros de los frenos S600_BrakeSystem 



 

34 
 

Modelado y simulación dinámica del automóvil Fiat/Seat 600 

Grado en Ingeniería Mecánica 

5.8. Modelado de las ruedas 
 

5.8.1. Introducción 
 

El neumático y la llanta son los elementos que nos permiten enlazar el vehículo con el suelo. La 

adherencia del primero es la que nos permite tener un control del vehículo. 

El neumático nos permite gozar de mayor confort y estabilidad gracias a su estructura de caucho, 

mientras que la llanta nos permite soportar el neumático y transmitir las acciones de la 

suspensión, el motor y la dirección. 

La rueda, es decir, el conjunto de ambos, nos permite transmitir las diferentes fuerzas entre el 

vehículo y la calzada, ya que se trata de la única unión entre estos. 

Actualmente podemos encontrar una gran variedad de neumáticos con tecnologías sofisticadas 

que van mejorando a lo largo de los años. En nuestro caso, al tratarse el Seat-Fiat 600 de un 

coche clásico, el modelo montaba unos neumáticos diferentes a la nomenclatura actual, pero 

dado que estos coches aún existen, se han tenido que adaptar a la nomenclatura actual para 

montar neumáticos homologados. 

 

Fig.5.38 Ruedas de banda blanco pertenecientes a un Seat 600. Ref. [17] 

 

Por lo tanto, el neumático homologado actual sería el 145/80/R12. Aunque gran parte de los 

automóviles actuales montan diferente neumático en la parte frontal y la trasera, en este caso 

el Fiat/Seat 600 al tratarse de un clásico monta todos sus neumáticos de igual medida.  
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Por lo tanto, los datos necesarios para el modelado de las ruedas del vehículo serán los 

siguientes: 

Neumático: 145/80 R12 – Radial de 12’’ con relación de aspecto 0.8 

Diámetro de la llanta: 12’’ – 304.8mm 

Anchura: 145 mm 

Relación de aspecto: 0.8 

Diámetro total: 536 mm 

 

5.8.2 Modelado 
 

Para el modelado de las ruedas serán necesarios los datos recientemente facilitados. Basaremos 

su modelado en una plantilla que nos facilita Adams Car, pero su modificación será algo 

diferente a los otros subsistemas. 

En primer lugar, debemos hacer dos copias del archivo handling_tire, que contiene la base de 

datos de Adams Car, en la carpeta Templates de nuestra base de datos. Cambiaremos los 

nombres, llamándoles S600_Front_Tires y S600_Rear_Tires respectivamente. 

En segundo lugar, y realizando el mismo procedimiento para ambos archivos, pulsaremos 

File>Open y elegiremos el Template creado. A continuación, importaremos el archivo CAD de las 

llantas y lo colocaremos en nuestras ruedas. Para ello, pulsamos File>Import, seleccionamos el 

tipo de archivo Parasolid, lo unimos a la parte whr_wheel (deberé importar otro archivo rotado 

180º para la otra rueda) y lo ubicaremos en la dirección y posición correspondientes. Acabando 

en el modo Template, guardaremos los cambios creados. 

 

Fig.5.39 Plantilla S600_Front_Tires.tbl 
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En tercer lugar, debo crear los subsistemas correspondientes a las plantillas. Para ello, nos 

dirigimos al modo Standard Interface, pulsamos New>Subsystem y creamos ambos subsistemas. 

Por un lado, para las ruedas delanteras, le llamaré S600_Front_Tires y le asignaré Minor Role: 

Front. Por otro lado, para las ruedas traseras, le llamaré S600_Rear_Tires y le asignaré Minor 

Role: Rear.  

En cuarto lugar, deberemos acudir a la base de datos de Adams Car, copiar el archivo pac89 y 

pegarlo dos veces en la carpeta Tires.tbl de nuestra base de datos. A estos archivos, les 

modificamos el nombre llamándolos S600_front_pac89 y S600_rear_pac89 respectivamente. 

Seguidamente, deberemos asignar las propiedades de estos archivos a nuestras ruedas por lo 

que iremos a nuestro subsistema y en el menú Browse>Force Elements>Tires seleccionaremos 

las ruedas y las modificaremos dándoles como archivo de propiedades los creados 

anteriormente. 

Finalmente, y tras guardas los subsistemas, para modificar las propiedades tan solo debemos 

modificar los archivos S600_front_pac89 y S600_rear_pac89. Por ello, los abrimos con un editor 

de texto y le añadimos los datos de nuestras ruedas: UNLOADED_RADIUS 268.4, WIDHT 145 y 

ASPECT_RATIO 0.8. Introduciré lo mismo en ambos archivos ya que las ruedas delanteras y 

traseras son iguales. Con esto ya tendríamos finalizado el modelado de las ruedas. 

 

 

Fig.5.40 Subsistema S600_Front_Tires 
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5.9. Vehículo final 
 

Como paso final a todo el proceso de modelado, debemos juntar todos los subsistemas creados 

y asegurarnos de que todo ensambla de forma correcta. 

Para ello, en el modo Standard Interface, nos dirigimos a File>New>Full-Vehicle Assembly y 

vamos rellenando las casillas con cada uno de los subsistemas creados anteriormente. 

 

Fig.5.41 Full-Vehicle Assembly del modelo Fiat/Seat 600 

Pulsaremos la tecla OK, y el programa procederá a juntarnos todos los subsistemas con sus 

respectivos conectores. El resultado final será el siguiente: 

 

Fig.5.42 Modelo del Fiat/Seat 600 creado en el programa MSC Adams Car 
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6. Simulación dinámica del vehículo 
 

6.1. Introducción 
 

En el mundo del automóvil es muy importante analizar el comportamiento de los componentes 

al ser sometidos a un ensayo. Por ello, la herramienta Adams Car nos facilita el análisis del 

comportamiento de estos componentes permitiéndonos crear un modelo simular a la realidad. 

Este tipo de ensayo informáticos ayudan al ingeniero a entender de mejor manera los 

comportamientos de la dinámica de sistemas mecánicos, y trata de hacerles aprender las formas 

de optimizar y mejorar sus modelos.  

Por ello, en este trabajo fin de grado hemos decidido simular el comportamiento de un coche 

tan importante como es el Seat 600, y lo haremos de la siguiente forma: 

 Análisis individual de la suspensión delantera 

 Análisis de la suspensión delantera y la dirección. 

 Análisis individual de la suspensión trasera 

 Análisis total del vehículo (aceleración, frenada y cambios de dirección) 

Como objetivo, esperamos que al terminar todos estos ensayos hayamos conseguido entender 

un poco más del funcionamiento de este automóvil, y si fuese posible, buscar posibilidades de 

optimización de cara a futuras restauraciones.  

 

6.2. Simulación dinámica individual 
 

6.2.1. Ensamblaje de suspensión delantera y dirección 
  

Para la realización de este tipo de ensayos es necesarios tener lo que Adams Car llama 

Suspension Assembly. Para ello, dentro del modo Standard Interface, pulsamos el botón 

File>New>Suspension Assembly y colocamos los subsistemas a analizar, en este caso, 

S600_Front_Suspension. 

 

6.2.1.1. Simulación Parallel Wheel Travel 

 

El modo de simulación Parallel Wheel Travel se basa en el funcionamiento de dos plataformas. 

En este caso, ambas plataformas suben y bajan de igual manera generando fuerzas en la 

amortiguación. Como detalle, es necesario saber que este tipo de ensayos no incluyen el 

subsistema de la dirección. 

Para realizar este tipo de simulación debemos estar en el modo Standard Interface con el 

Suspension Assembly correspondiente abierto, luego pulsaremos Simulate>Suspension 

Analisis>Parallel Wheel Travel. A continuación, se nos abrirá una ventana en la cual 

introduciremos los datos de la simulación, en nuestro caso puedes observarlos en la Figura 6.1. 
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Fig.6.1 Datos de simulación Parallel Wheel Travel (Suspensión delantera) 

 

Tras realizar la simulación satisfactoriamente sería interesante analizar los resultados. Por ello, 

hemos decidido observar gráficamente como se ven afectado los ángulos característicos de la 

suspensión. 

 

Gráfico.6.1 Análisis de los ángulos característicos en el modo Parallel Wheel Travel. (Suspensión Delantera) 

 

Podemos observar gráficamente que el ángulo de avance se eleva de una forma muy reducida 

siendo prácticamente imposible de apreciar respecto a la variación de los otros ángulos. 
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Respecto, al ángulo de caída, vemos que realiza una parábola, la cual tiene una amplitud 

aproximada de 1 grado. Finalmente, de forma opuesta al valor del ángulo de caída, realiza una 

parábola cóncava, pero esta parábola no es tan exagerada como en el caso del ángulo de caída. 

 

6.2.1.2. Simulación Opposite Wheel Travel 

 

El modo de simulación Opposite Wheel Travel tiene un funcionamiento muy similar al modo 

Parallel Wheel Travel. La diferencia entre ambas simulaciones es que en el modo Opposite Wheel 

Travel las ruedas se comportan de forma totalmente opuesta. 

Para realizar este tipo de simulación debemos estar en el modo Standard Interface con el 

Suspension Assembly correspondiente abierto, luego pulsaremos Simulate>Suspension 

Analisis>Opposite Wheel Travel. A continuación, se nos abrirá una ventana en la cual 

introduciremos los datos de la simulación, en nuestro caso puedes observarlos en la Figura 6.2. 

 

 

Figura.6.2 Datos de simulación Opposite Wheel Travel (Suspensión delantera) 

 

Del mismo modo que en el ensayo anterior, también sería interesante conocer el 

comportamiento de los ángulos característicos con un comportamiento opuesto. Para ello, nos 

hemos apoyado de la herramienta gráfica que nos facilita Adams Car. 
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Gráfico.6.2 Análisis de los ángulos característicos en el modo Opposite Wheel Travel. (Suspensión Delantera) 

 

Observando ambas gráficas podemos ver que el comportamiento es idéntico. Esto se debe a 

que se trata de una suspensión independiente, por lo tanto, el funcionamiento de la otra parte 

de la suspensión (izquierda y derecha) no influye directamente en la suspensión opuesta. 

 

 

6.2.1.3. Simulación “Steering” (Dirección) 

 

Otras de las opciones que nos facilita Adams Car es simular el comportamiento de la suspensión 

directriz junto a la dirección. Para ello, debemos crear un Suspension Assembly con ambas partes 

(Figura 6.3). 

 

Fig.6.3. Configuración de Suspension Assembly juntando suspensión y dirección 

Este tipo de simulación nos permite girar el volante el ángulo asignado, esto producirá el giro de 

las ruedas el cual sería interesante analizar. 

Para realizar este análisis, pulsamos Simulate>Suspension Analysis>Steering. En nuestra 

simulación haremos que nuestro volante gire una vuelta entera, es decir, 360º. Podemos 

observar los datos introducidos en la siguiente figura (Figura 6.4). 
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Fig.6.4 Datos introducidos en la simulación Steering 

 

 

Gráfico.6.3 Análisis de los ángulos característicos en el modo Steering. (Suspensión Delantera) 

Si observamos los gráficos vemos que tanto el ángulo de avance como el ángulo de caída sufren 

unas variaciones inapreciables si las comparamos con el ángulo de convergencia.  

De forma opuesta, el ángulo de convergencia sufre una gran variación a medida que se produce 

el giro de la dirección. Es curioso observar que se trata de un comportamiento lineal, y que en 

el caso de ángulo de giro positivo el ángulo de convergencia toma valores negativos. Además, 

vemos que en el momento que el volante no está girado (0º) el ángulo de convergencia tiene un 

valor de 0. 
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6.2.2. Ensamblaje de la suspensión trasera 
 

En los siguientes casos, analizaremos los comportamientos de la suspensión trasera, por lo 

tanto, debemos crear el Suspension Assembly con el subsistema S600_Rear_Suspension.  

Para realizar esto debemos abrir el Adams Car en el modo Standard Interface, pulsar 

File>New>Suspension Assembly y usar el fichero correspondiente. En este caso al ser ruedas 

motrices y no directrices no hará falta realizar ninguno ensayo de dirección. 

 

6.2.2.1. Simulación Parallel Wheel Travel 

 

Para realizar este tipo de simulación debemos estar en el modo Standard Interface con el 

Suspension Assembly correspondiente abierto, luego pulsaremos Simulate>Suspension 

Analisis>Paralellel Wheel Travel. A continuación, se nos abrirá una ventana en la cual 

introduciremos los datos de la simulación, en nuestro caso puedes observarlos en la Figura 6.5. 

 

Fig.6.5 Datos introducidos a la simulación Parallel Wheel Travel (Suspensión Trasera) 

 

Como en ensayos anteriores, sería muy curioso observar gráficamente la variación de los 

ángulos característicos correspondientes, en este caso, a la suspensión trasera. 
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Gráfico.6.4 Análisis de los ángulos característicos en el modo Parallel Wheel Travel. (Suspensión Trasera) 

Podemos observar, como el ángulo de caída sufre una gran variación respecto a los otros 

ángulos. Este empiezas en la zona positiva y a medida que avanza el ensayo decrece de forma 

lineal hasta valores negativos. 

Respecto a los ángulos de avance y convergencia sufren pequeñas variaciones casi inapreciables 

al lado del ángulo de caída. 

 

6.2.2.2. Simulación Opposite Wheel Travel 

 

Para realizar este tipo de simulación debemos estar en el modo Standard Interface con el 

Suspension Assembly correspondiente abierto, luego pulsaremos Simulate>Suspension 

Analisis>Opposite Wheel Travel. A continuación, se nos abrirá una ventana en la cual 

introduciremos los datos de la simulación, en nuestro caso puedes observarlos en la Figura 6.6. 

 

Fig.6.6 Datos introducidos a la simulación Parallel Wheel Travel (Suspensión Trasera) 
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Respecto a los datos obtenido, sería interesante comparar los ángulos característicos de la 

suspensión. Así nos permitiría analizar de mejor forma su comportamiento antes estímulos 

parecidos al producido por este ensayo. 

 

Gráfico.6.5 Análisis de los ángulos característicos en el modo Opposite Wheel Travel. (Suspensión Trasera) 

Gráficamente podemos observar como el ángulo de caída empieza en un valor positivo y a 

medida que avanza el ensayo va reduciendo su valor de forma lineal hasta valores negativos. 

Por otro lado, igual que en el Parallel Wheel Travel, los otros dos ángulos varían muy poco con 

respecto al ángulo de caída. 

Podemos concluir diciendo que el comportamiento en ambos ensayos es prácticamente igual, 

esto se debe a que la suspensión trasera es independiente. 

 

 

 

6.3. Simulación dinámica del vehículo 
 

De la misma manera que es interesante analizar el comportamiento de la suspensión de forma 

individual, también es muy importante analizar el comportamiento del vehículo entero.  

Esto nos permitirá conocer un comportamiento más global y avanzado de la dinámica del 

vehículo. Gracias a este tipo de ensayos podremos conocer el comportamiento del vehículo de 

una forma aproximada lo que nos permitirá optimizar el modelo para mejorar sus prestaciones. 

Para realizar los análisis de vehículo completo debemos abrir el archivo Full-Vehicle Assembly 

creado antes. Para ello, situados en el modo Standard Interface pulsamos File>Open>Assembly 

y seleccionamos SEAT_600.asy. 
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6.3.1. Simulación de aceleración 
 

La simulación de aceleración, como bien dice su nombre, consiste en acelerar el vehículo para 

observar el comportamiento ante este estímulo. Este tipo de ensayo nos permite elegir varias 

opciones como el porcentaje de aceleración, el tiempo de aceleración, etc. En el caso de nuestro 

ensayo hemos elegido las siguientes opciones (Figura 6.7). 

 

Fig.6.7 Opciones de la simulación Acceleration. 

 

Para entender el comportamiento del Fiat/Seat 600 a este estímulo vamos a analizar una serie 

de gráficas que nos ha proporcionado el programa. Además, este tipo de ensayo nos permite 

ver una simulación visual del comportamiento del coche. 

La primera gráfica que podemos observar es la de velocidad del automóvil (Gráfica 6.6). Vemos 

como en los 20 segundo de aceleración el vehículo alcanza una velocidad aproximada de 

85km/h. Si comparamos con estudios reales del Seat 600 [18], la velocidad alcanzada está dentro 

de los parámetros alcanzables por el coche real, ya que el Seat 600 era capaz de alcanzar 95km/h 

en 35 segundos. 
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Gráfica 6.6 Análisis de la velocidad del vehículo 

 

También sería interesante observar la distancia que sería capaz de recorrer el vehículo en este 

tiempo. Observando la gráfica de desplazamiento (Gráfica 6.7) podemos ver que en 20 segundos 

nuestro modelo ha sido capaz de recorrer 300 metros. Si comparamos el dato con coches de la 

época sería un resultado muy pobre, pero al tratarse de un automóvil del año 1957 el resultado 

está acorde con el comportamiento de los vehículos de la época. 

 

Gráfica 6.7 Análisis del desplazamiento del vehículo  

 

Además, uno de los componentes más interesante a analizar en este tipo de ensayos sería el 

motor. Si observamos el gráfico de revoluciones por minuto (Gráfica 6.8), vemos que se 

producen picos y bajadas bruscas que se corresponde con los cambios de marchas que podemos 

observar en el otro gráfico (Gráfica 6.9). Además, vemos como al aumentar la velocidad del 

coche, y por lo tanto las marchas, el motor alcanza de forma más lenta el límite de revoluciones. 

Si comparamos los datos con análisis de vehículos reales, vemos como el comportamiento es 

similar, por lo tanto, nuestro modelo se ajusta a la realidad. 
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Gráfica 6.8 Análisis de las revoluciones del motor 

 

 

Gráfico 6.9 Análisis de la relación de marchas 

 

Finalmente, sería interesante analizar el cabeceo que se produce en nuestro vehículo al acelerar 

a máxima potencia. Observando el gráfico (Gráfica 6.10) podemos ver como en el cambio entre 

primera y segunda marcha el cabeceo producido es mucho mayor que en los otros cambios, esto 

se debe a que el par transmitido a las ruedas también es mayor debido a la relación de 

transmisión. 
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Gráfica 6.10 Análisis del cabeceo producido en la aceleración 

 

 

6.3.2. Simulación de frenada 
 

La simulación de frenado, como bien dice el nombre, nos permite reproducir una serie de 

condiciones de frenado cambiando parámetros como el porcentaje de frenado, el tiempo que 

inicia el frenado o la velocidad inicial del vehículo antes de iniciar a frenar. En nuestro caso, 

hemos decido usar los siguientes parámetros: 

 

Fig.6.8 Opciones de la simulación de frenado 
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Observando los resultados de la simulación, vemos que el vehículo se detiene en un tiempo 

aproximado de 15 segundos. Se tratan de valores que en la actualidad nos pueden parecer muy 

grandes, pero en la época del vehículo (1957) era un valor normal. Por lo tanto, observando el 

gráfico de velocidad podemos decir que el sistema de frenado se aproxima al funcionamiento 

del modelo real. 

 

 

Gráfica 6.11 Análisis de velocidad en simulación de frenado 

 

Por otro lado, si observamos el comportamiento del ángulo de cabeceo vemos que el coche 

aumenta su ángulo al iniciar la frenada de gran medida al iniciar la frenada para luego 

estabilizarse alrededor de un valor (0.5-0,55 grados. Se trata de un comportamiento normal en 

las hipótesis de frenado, por lo tanto, nuestro modelo se ajusta con la realidad. 

 

 

Gráfica 6.12 Análisis del ángulo de cabeceo en simulación de frenado 
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Finalmente, sería interesante comparar los pares de frenos aplicados en el tren delantero 

como en el tren trasero. En todos los vehículos, su tren de frenado de delantero ejerce mayor 

fuerza de frenado, en nuestro caso vemos que también sucede esto. 

 

 

Gráfica 6.13 Análisis del par de frenado en la simulación de frenada 

 

6.3.3. Simulación de frenada en curva 
 

La simulación de frenado en curva nos permite desacelerar el vehículo mientras realiza un giro 

constante en un período de tiempo. Para realizar este tipo de ensayo podemos elegir varios 

parámetros como por ejemplo la aceleración lateral, el radio de giro o la duración de frenado. 

En nuestro caso hemos elegido los siguientes parámetros (Figura 6.10). 

 

 

Fig.6.9 Parámetros del análisis de frenada en curva 
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Si observamos mediante gráficas el resultado, podemos entender mejor el funcionamiento de 

nuestro modelo. En primer lugar, observando las gráficas de velocidad (Gráfica 6.16) y cambio 

de marchas (Gráfica 6.17) podemos observar que la disminución de velocidad hace que nuestro 

vehículo tenga que reducir la marcha. Esta disminución de velocidad se comporta de forma lineal 

hasta que nuestra caja de cambios debe reducir la marcha que el comportamiento de la 

velocidad varía en pequeña medida. 

 

Gráfica 6.14 Análisis de la velocidad del vehículo 

 

 

Gráfica 6.15 Análisis de relación de marchas del vehículo 

 

En segundo lugar, sería interesante también analizar el resultado de los comportamientos 

laterales del vehículo. En las siguientes gráficas podemos ver como nuestro vehículo aumenta 

su aceleración lateral (Gráfica 6.18) debido a la frenada, y como es lógico, también aumenta su 

velocidad lateral (Gráfica 6.19). 
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Gráfica 6.16 Análisis de la aceleración lateral del vehículo 

 

 

Gráfica 6.17 Análisis de la velocidad lateral del vehículo 

 

Finalmente, observando el comportamiento del ángulo de cabeceo (Gráfica 6.20) podemos 

observar como al frenar este ángulo aumenta rápidamente llegando a un valor pico el cual va 

disminuyendo de forma ordenada hasta que se produce una oscilación hacia ángulos de cabeceo 

negativos prácticamente al final de la maniobra. 
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Gráfica 6.18 Análisis del ángulo de cabeceo 

 

 

6.3.4. Simulación de giro en curva de radio constante 
 

La simulación de giro en curva de radio constante nos permite analizar el comportamiento del 

vehículo al realizar una aceleración de este mientras gira un determinado radio. Este tipo de 

ensayo nos permite ajustar algunos parámetros como son la velocidad inicial, velocidad final, 

radio de giro o duración de la maniobra. En nuestro caso, hemos elegido los siguientes 

parámetros de funcionamiento (Figura 6.11). 

 

Fig.6.10 Parámetros en el análisis de giro en curva de radio constante 
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Pasando al análisis de resultados, si observamos la gráfica de velocidad vemos como esta 

aumenta de forma lineal hasta aproximadamente el segundo 16, en el cual se produce un 

pequeño cambio y avanza de forma diferente, comparado con la gráfica del cambio de marcha 

vemos que este cambio se debe a la necesidad de subir de marcha debido a la velocidad. 

Además, observando la gráfica del balanceo, vemos que este ángulo va aumentando a medida 

que aumenta la velocidad de nuestro vehículo, un ángulo de balanceo muy grande podrías 

llevarnos a problemas de volcado por lo que es interesante evitarlos. 

 

 

Gráfica 6.20 Análisis de la velocidad del vehículo 

 

 

Gráfica 6.21 Análisis de la relación de marchas del vehículo 
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Gráfica 6.22 Análisis del ángulo de balanceo del vehículo 

 

También, al tratarse de un ensayo en curva, sería interesante analizar el comportamiento lateral 

del vehículo. En la siguiente gráfica (Gráfica 6.24) podemos observar el comportamiento de la 

aceleración lateral, vemos que conforme avanza el ensayo la aceleración lateral aumenta menos 

en un pequeño periodo que sufre una pequeña reducción, este periodo se corresponde al 

periodo en el que el coche realiza el cambio de marchas.  

 

 

Gráfica 6.23 Análisis de la aceleración lateral del vehículo 

 

Finalmente, observando la velocidad lateral del vehículo (Gráfica 6.25), vemos como esta avanza 

a medida que avanza el ensayo, y al igual que en la aceleración, se produce una pequeña 

oscilación en el momento del cambio de marchas. 
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Gráfica 6.24 Análisis de la velocidad lateral del vehículo 

 

6.3.5. Simulación ISO Lane Change 
 

La simulación ISO Lane Change consta de un carril de entrada-salida y un carril lateral, nuestro 

vehículo debe pasar al carril lateral y posteriormente volver al carril de salida. Este tipo de 

ensayos nos ayuda a analizar el comportamiento lateral del vehículo. Nosotros realizaremos este 

ensayo a 30km/h pero en la vida real en estos ensayos se va incrementando la velocidad hasta 

que el coche no es capaz de realizar la trayectoria. Los datos utilizados en nuestro ensayo son 

los siguientes (Figura 6.12). 

 

 

Fig 6.11 Parámetros para en ensayo ISO Lane Change 
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Pasando a analizar los resultados obtenidos, si analizamos el ángulo de balanceo que se produce 

en el ensayo observamos que en el momento de producirse los giros el coche gira respecto a su 

eje longitudinal. Se trata de un comportamiento normal al realizar este tipo de ensayos, ya que 

los giros realizados suelen producir este tipo de reacción en el chasis debido a la actuación de la 

suspensión. 

 

 

Gráfica 6.25 Análisis del ángulo de balanceo 

 

Otro dato interesante a analizar sería el desplazamiento lateral, en este caso vemos como en el 

momento que se producen los suben y bajan los valores de este. Se trata de un comportamiento 

normal que hemos podido comprar con otros vehículos sometidos a este tipo de análisis [19]. 

 

Gráfica 6.26 Análisis del desplazamiento lateral 
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Finalmente, sería interesante analizar la aceleración lateral a la que se ve sometida el vehículo. 

Vemos que la gráfica (Gráfica 6.28) coincide en forma con la del ángulo de balanceo. Cuando el 

vehículo modifica su trayectoria este es sometido a aceleraciones laterales, mientras que 

cuando su trayectoria es recta estas aceleraciones se estabilizan. 

 

Gráfica 6.27 Análisis de la velocidad lateral 
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7. Conclusiones y futuros trabajo 
 

7.1. Conclusiones 
 

El análisis de la dinámica de vehículos nos permite conocer de forma aproximada el 

funcionamiento de los automóviles. En nuestro caso, nos pareció interesante estudiar los 

comportamientos del Fiat/Seat 600 para ver si era posible crear un coche clásico en programas 

modernos que no se usaban en la época de diseño de estos coches. 

Al principio del trabajo tuvimos que recabar mucha información sobre el vehículo para tratar de 

crear toda su geometría idéntica para un funcionamiento similar. Tras esto, con la geometría ya 

obtenida, pasamos al diseño dentro del programa. 

A lo largo de este diseño, hemos ido dándonos cuenta de la importancia de la simulación 

mediante ordenador, ya que gracias a esta hemos podido ajustar parámetros de nuestro modelo 

sin necesidad de un alto coste económico. Este ajuste, nos ha permitido que el modelo 

conseguido tenga un funcionamiento muy similar al vehículo real. 

Si observamos las gráficas de los ensayos realizados, vemos que son muy simulares a las 

obtenidas analizando otros vehículos o a las obtenidas con ensayos efectuados en la realidad 

como podría ser el de cambio de dirección (ISO Lane Change). 

Además, este trabajo fin de grado nos ha permitido avanzar en nuestro de nivel de manejo en 

programas como Adams Cars o Solid Works. Estos conocimientos nos servirán de gran ayuda en 

el futuro, permitiéndonos analizar otros vehículos o apoyarnos en estas plataformas para 

realizar nuevos proyectos. 

También nos ha permitido aprender detalles sobre los vehículos, sus componentes o el uso de 

herramientas Office para la realización de trabajos o documentos.  

Finalmente, centrándonos en el modelo creado, podemos concluir que se trata de un modelo 

con un comportamiento similar a la realidad, el cual tiene un comportamiento muy parecido al 

vehículo real. Por lo tanto, podremos apoyarnos en este modelo para tratar de mejorar el 

modelo real. 

 

 

7.2. Futuros Trabajos 
 

Tras el modelo realizado, sería interesante tratar de aplicarle mejoras que serían posible aplicar 

al coche real, consiguiendo así, optimizar el modelo real para un mejor funcionamiento. 

Otro trabajo futuro interesante sería el crear otro modelo Seat 600, pero en este caso crear el 

modelo Abarth, se trata de un modelo adaptado a la actualidad el cual consta de un motor 

mucho más potente y se usa para competiciones. Tras la creación de este modelo, 

compararíamos el funcionamiento de ambos coches para ver como el avance de la tecnología 

ha conseguido mejorar un coche tan típico como es el Seat 600. 
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En conclusión, sería muy interesante comparar nuestro modelo con otros modelos creados en 

el programa para ver donde mejorar el funcionamiento de algunos estos, además de que sería 

útil para poder introducir mejoras al modelo real. 
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8. Presupuesto 
 

A la hora de calcular el presupuesto de este trabajo fin de grado sería interesante dividirlo en 

dos partes. Por una parte, las horas de trabajo realizadas tanto por el autor como por el tutor a 

cargo. Por otra parte, los costes informáticos necesarios para la simulación del proyecto, ya que 

un programa como Adams Car no puede ser procesado en cualquier ordenador y su licencia es 

de alto coste. 

 

Horas del personal 

 

Concepto Cantidad de horas Precio Parcial 

Ingeniero Mecánico 321 10,00 € 3.210,00 € 

Director del proyecto 35 16,00 € 560,00 € 

    Total 3.770,00 € 

 

 

Software informático 

Concepto Cantidad de horas 
Precio 
licencia 

Autodesk AutoCAD 2016 Mensual 10 223,85 € 

Solidworks 2016 Student Edition 23 150,00 € 

Microsoft Office Professional 
2017 55 539,00 € 

MSC Adams/Car 2017 233 1.851,00 € 

  Total 2.763,85 € 

 

 

Equipo informático 

Concepto Cantidad de horas Precio 

Hp Pavilon dV7 321 803,00 € 

  Total 803,00 € 

  

  
 
 
 
   

  Precio total del proyecto 7.336,85 € 

   

El coste final de este proyecto sería siete mil trescientos treinta y seis con ochenta y cinco 

centésimas. 



 

63 
 

Modelado y simulación dinámica del automóvil Fiat/Seat 600 

Grado en Ingeniería Mecánica 

9. Pliego de condiciones 
 

9.1 Comentario 
 

Debido a que el trabajo ha sido realizado mediante métodos informáticos no existen leyes, 

condiciones técnicas o ambientales a las que ceñirse. 

No obstante, si había una serie de parámetros a los que ceñirse para que el vehículo tuviese un 

comportamiento parecido al vehículo real.  

 

9.1.1 Reseña 
 

La serie de parámetros a los que debíamos ceñirnos para que el modelo de simulación fuese 

valido, son los siguientes:  

 Utilización del mismo modelo de suspensión usado por el modelo original. 

 Medidas y geometría de los subsistemas del vehículo que nos permitiesen un 

funcionamiento similar al original. 

 Utilización del programa MSC Adams Car. 

El proyecto realizado debía ser lo más parecido posible al modelo original del Seat 600, debido 

a que, en un futuro, podría ser posible apoyarse en este modelo para realizar mejorar en el 

vehículo original. 

 

9.2 Condiciones recomendadas de utilización 
 

Al tratarse un trabajo realizado mediante métodos informáticos, nuestros recursos a usar 

deben de cumplir un mínimo para el correcto funcionamiento de los programas a utilizar. Sin 

cumplir esta serie de condiciones no sería posible ejecutar las diferentes herramientas usadas, 

es decir, realizar este trabajo. 

Las condiciones son las siguientes: 

 

9.2.1 Condiciones de Software y Hardware 
 

Al estar trabajado con programas muy potentes, necesitaremos que nuestro ordenador 

cumpla las siguientes condiciones para un correcto funcionamiento. Dependiendo el programa 

usado necesitaremos unos requerimientos u otros, pero nuestro ordenador siempre debería 

estar por encima para el funcionamiento óptimo.  
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9.2.1.1 MSC Adams 2017. 

 

Fig.9.1 Requerimientos de Software y Hardware de MSC Adams 

 

Fig.9.2 Requerimientos de nuestro procesador gráfico en MSC Adams 
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9.2.1.2 SolidWorks Products 

 

Fig.9.3 Requerimientos de software y hardware de SolidWorks 

9.2.1.3Autodesk AutoCAD 2017 

 

Fig.9.4 Requerimientos de software y hardware de Autodesk AutoCAD (1). 
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Fig.9.5 Requerimientos de software y hardware de Autodesk AutoCAD (2). 

 

9.2.2 Condiciones generales 
 

Son las condiciones a las cuales nos debemos ceñir para que el modelo tenga un correcto 

funcionamiento. Serían las siguientes: 

 El tiempo de aceleración y frenado deben estar dentro de unos parámetros lo más 

cercanos posible al modelo real. 

 El comportamiento de los subsistemas al realizar los diferentes ensayos debe ser lo 

más parecido posible al comportamiento real del vehículo al realizar el mismo ensayo. 

 El motor debe tener unas curvas de funcionamiento aproximadas. 

 La transmisión debe ser lo más parecida posible a la del vehículo original, es decir, las 

relaciones de las marchas deben ser similares a las reales. 

 

El correcto cumplimiento de todas estas condiciones nos va a permitir que nuestro modelo 

funcione de forma simular al modelo real. 
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Anexo I: Característica técnicas del Fiat/Seat 600 

 

Datos del vehículo Seat 600 facilitados en el “Manual de Reparación” oficial de Seat. 
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Pesos y datos del motor facilitidados en el “Manual de Repación” oficial de Seat. 

 

Planta del modelo Seat 600 facilitado en el “Manual de Reparación” oficial de Seat. 
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Anexo II: Ficheros de los subsistemas 
1. S600_Rear_Suspension 
 

Info for subsystem: S600_Rear_Suspension 

 

File Name : <private>/subsystems.tbl/S600_Rear_Suspension.sub 

Template : mdids://private/templates.tbl/_S600_REARSUSPENSIONFINAL.tpl 

Comments : 

Template : Simple Trailing Arm Rear Suspension 

Subsystem : *no subsystem comments found* 

Major Role : suspension 

Minor Role : rear 

 

 

HARDPOINTS: 

hardpoint name symmetry x_value y_value z_value 

-------------- -------- ------- ------- ------- 

subframe_fixed single 2386.5 0.0 -652.5 

arm_inner_pivot left/right 2261.5 -80.0 -302.5 

arm_outer_pivot left/right 1852.5 -455.0 -302.5 

arm_strut_bushing left/right 2261.5 -430.0 -302.5 

arm_strut_bushing_x left/right 2061.5 -280.0 -302.5 

arm_strut_bushing_z left/right 2011.5 -330.0 -302.5 

drive_shaft_inr left/right 2386.5 -200.0 -252.5 

spring_lower_seat left/right 2261.5 -430.0 -302.5 

spring_upper_seat left/right 2261.5 -405.0 -2.5 

subframe_front left/right 1652.5 -355.0 -282.5 

subframe_rear left/right 2436.5 -170.0 -302.5 

top_mount left/right 2261.5 -405.0 -2.5 

wheel_center left/right 2386.5 -580.0 -302.5 

 

 

PARTS: 

subframe 

symmetry : single 

mass : 50.0 

sprung_percentage : 100.0 

location : 0.0, 0.0, 0.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 150.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

arm 

symmetry : left/right 

mass : 5.357697727 

sprung_percentage : 100.0 

location (dependent) : 2386.5, -580.0, -302.5 

orientation (dependent) : zp_vector=0.9736795699, -0.2279212476, 0.0 

: xp_vector=0.2279212476, 0.9736795699, 0.0 

cm_location_from_part : 145.3990551692, 0.0, -247.744295992 

Ixx, Iyy, Izz : 8.4170301754E+04 , 1.5199501933E+05 , 6.7877361313E+04 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

arm arm geometry 

name : arm 

symmetry : left/right 
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thickness : 5.0 

 

drive_shaft 

symmetry : left/right 

mass : 4.2174529406 

sprung_percentage : 100.0 

location (dependent) : 2386.5, -200.0, -252.5 

orientation (dependent) : zp_vector=0.0, 0.9909924304, 0.133917896 

: xp_vector=0.0, -0.133917896, 0.9909924304 

cm_location_from_part : 0.0, 0.0, -365.6817014651 

Ixx, Iyy, Izz : 1.6598906562E+05 , 1.6598906562E+05 , 692.8258536527 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

drive_shaft link geometry 

name : drive_shaft 

symmetry : left/right 

radius : 15.0 

 

lower_strut 

symmetry : left/right 

mass : 3.032811081 

sprung_percentage : 100.0 

location (dependent) : 2261.5, -421.5, -200.5 

orientation (dependent) : zp_vector=0.0, 8.3045479854E-02, 0.9965457582 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0382070533E+04 , 1.0382070533E+04 , 947.7534628024 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

spindle 

symmetry : left/right 

mass : 1.1028403931 

sprung_percentage : 100.0 

location (dependent) : 2386.5, -580.0, -302.5 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 15.0 

Ixx, Iyy, Izz : 477.8975036678 , 477.8975036678 , 496.2781768857 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

tripot 

symmetry : left/right 

mass : 1.9851127075 

sprung_percentage : 100.0 

location (dependent) : 2386.5, -200.0, -252.5 

orientation (dependent) : zp_vector=0.0, 1.0, 0.0 

: xp_vector=0.0, 0.0, -1.0 

cm_location_from_part : 0.0, 0.0, 13.8888888889 

Ixx, Iyy, Izz : 1101.8600905078 , 1101.8600905078 , 813.8962100926 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

upper_strut 

symmetry : left/right 

mass : 4.3672479566 

sprung_percentage : 100.0 

location (dependent) : 2261.5, -413.25, -101.5 

orientation (dependent) : zp_vector=0.0, 8.3045479854E-02, 0.9965457582 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.5250429864E+04 , 1.5250429864E+04 , 1965.2615804675 
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Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

 

 

BUSHINGS: 

arm_inner_pivot 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=-0.7370793295, -0.6758062312, 0.0 

: xp_vector=0.6758062312, -0.7370793295, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

arm_outer_pivot 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=0.7370793295, 0.6758062312, 0.0 

: xp_vector=0.6758062312, -0.7370793295, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 
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ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

hub_compliance 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 0.0 

fy scaling factor : 0.0 

fz scaling factor : 0.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 0.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/MDI_hub_compliance.bus 

 

lwr_strut_to_arm 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=-0.9284766909, 0.3713906764, 0.0 

: xp_vector=0.3713906764, 0.9284766909, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 
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tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

subframe_front 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

subframe_rear 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 
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tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

upr_strut_to_body 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

 

 

NSPRINGS: 

ride_spring 

definition : .ACAR.forces.ac_spring 

symmetry : left/right 

property file : mdids://private/springs.tbl/REAR_SUSP_600.spr 

value type : 'installed_length' 

user value : 331.8885355055 

 

 

 

DAMPERS: 

ride_damper 

definition : .ACAR.forces.ac_damper 

symmetry : left/right 

property file : mdids://acar_shared/dampers.tbl/mdi_0001.dpr 
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BUMPSTOPS: 

jounce_bumper 

definition : .ACAR.forces.ac_bumpstop 

symmetry : left/right 

property file : mdids://acar_shared/bumpstops.tbl/mdi_0001.bum 

distance type : 'clearance' 

user distance : 280.9456148675 

 

 

 

REBOUNDSTOPS: 

reboundstop_bumper 

definition : .ACAR.forces.ac_reboundstop 

symmetry : left/right 

property file : mdids://acar_shared/reboundstops.tbl/mdi_0001.reb 

distance type : 'clearance' 

user distance : 0.9456148675 

 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

driveline_active single integer 1 

kinematic_flag single integer 0 

hub_compliance_active single integer 0 

hub_compliance_offset single real 0.0 

camber_angle left/right real 0.0 

drive_shaft_offset left/right real 10.0 

toe_angle left/right real 0.0 

 

 

 

 

2. S600_Front_Suspension 
 

Info for subsystem: S600_Front_Suspension 

 

File Name : <private>/subsystems.tbl/S600_Front_Suspension.sub 

Template : mdids://private/templates.tbl/_FIAT600_Front_Suspension.tpl 

Comments : 

Template : Simple Double Wishbone Suspension 

Subsystem : *no subsystem comments found* 

Major Role : suspension 

Minor Role : front 

 

 

HARDPOINTS: 

hardpoint name symmetry x_value y_value z_value 

-------------- -------- ------- ------- ------- 

lca_front left/right 223.5 -274.0 -372.0 

lca_outer left/right 283.5 -500.0 -372.0 
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lca_rear left/right 343.5 -274.0 -372.0 

lwr_strut_mount left/right 283.5 -404.0 -327.0 

subframe_front left/right -116.5 -225.0 -372.0 

subframe_rear left/right 683.5 -225.0 -372.0 

tierod_inner left/right 500.0 -254.0 -287.0 

tierod_outer left/right 500.0 -450.0 -287.0 

top_mount left/right 283.5 -371.5 33.0 

uca_front left/right 193.5 -354.0 -202.0 

uca_outer left/right 283.5 -500.0 -202.0 

uca_rear left/right 373.5 -354.0 -202.0 

wheel_center left/right 283.5 -575.0 -287.0 

 

 

PARTS: 

subframe 

symmetry : single 

mass : 50.0 

sprung_percentage : 100.0 

location : 283.5, 0.0, -587.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 150.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

lower_control_arm 

symmetry : left/right 

mass : 6.5574254873 

sprung_percentage : 100.0 

location (dependent) : 283.5, -349.3333333333, -372.0 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=-1.0, 0.0, 0.0 

cm_location_from_part : 5.382811275, 0.0, 54.215675626 

Ixx, Iyy, Izz : 7.1240657504E+04 , 1.7168805784E+05 , 1.0195888543E+05 

Ixy, Izx, Iyz : 0.0 , -1.443881923E+04 , 0.0 

 

lower_control_arm link geometry 

name : lca_damper_mount_1 

symmetry : left/right 

radius : 10.0 

 

lower_control_arm link geometry 

name : lca_damper_mount_2 

symmetry : left/right 

radius : 10.0 

 

lower_control_arm link geometry 

name : lca_front 

symmetry : left/right 

radius : 15.0 

 

lower_control_arm link geometry 

name : lca_rear 

symmetry : left/right 

radius : 15.0 

 

lower_control_arm2 

symmetry : left/right 

mass : 1.0 

sprung_percentage : 100.0 
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location (dependent) : 283.5, -500.0, -372.0 

orientation (dependent) : zp_vector=0.0, 1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 100.0 , 100.0 , 100.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

lower_strut 

symmetry : left/right 

mass : 5.0 

sprung_percentage : 100.0 

location (dependent) : 283.5, -393.275, -208.2 

orientation (dependent) : zp_vector=0.0, 8.9912125907E-02, 0.9959497024 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

spindle 

symmetry : left/right 

mass : 1.1028403931 

sprung_percentage : 100.0 

location (dependent) : 283.5, -575.0, -287.0 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 15.0 

Ixx, Iyy, Izz : 477.8975036678 , 477.8975036678 , 496.2781768857 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

tierod_inner 

symmetry : left/right 

mass : 1.0 

sprung_percentage : 100.0 

location (dependent) : 500.0, -352.0, -287.0 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

tierod_inner link geometry 

name : tierod_inner 

symmetry : left/right 

radius : 12.0 

 

tierod_outer 

symmetry : left/right 

mass : 1.0 

sprung_percentage : 100.0 

location (dependent) : 500.0, -352.0, -287.0 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

tierod_outer link geometry 

name : tierod_outer 

symmetry : left/right 

radius : 10.0 
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upper_control_arm 

symmetry : left/right 

mass : 4.639404499 

sprung_percentage : 100.0 

location (dependent) : 283.5, -402.6666666667, -202.0 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=-1.0, 0.0, 0.0 

cm_location_from_part : -2.2372176837, 0.0, 25.010316486 

Ixx, Iyy, Izz : 2.4198898999E+04 , 3.1232703251E+04 , 7386.3617899892 

Ixy, Izx, Iyz : 1.0505055558E-11 , 2611.8081055757 , 2.3246441849E-11 

 

upper_control_arm link geometry 

name : uca_front 

symmetry : left/right 

radius : 15.0 

 

upper_control_arm link geometry 

name : uca_rear 

symmetry : left/right 

radius : 15.0 

 

upper_strut 

symmetry : left/right 

mass : 5.0 

sprung_percentage : 100.0 

location (dependent) : 283.5, -382.55, -89.4 

orientation (dependent) : zp_vector=0.0, 8.9912125907E-02, 0.9959497024 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

upright 

symmetry : left/right 

mass : 3.6382197927 

sprung_percentage : 100.0 

location (dependent) : 283.5, -575.0, -287.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 24.7110210574, 50.4417588916, 11.696029659 

Ixx, Iyy, Izz : 4.0802739044E+04 , 4.230634705E+04 , 8340.06541588 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

upright link geometry 

name : upright_lwr 

symmetry : left/right 

radius : 15.0 

 

upright link geometry 

name : upright_steer_arm 

symmetry : left/right 

radius : 15.0 

 

upright link geometry 

name : upright_upr 

symmetry : left/right 

radius : 15.0 
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SWITCH PARTS: 

ARB_pickup 

symmetry : left/right 

switched to : upright (general part) 

part list : upright (general part) 

: lower_control_arm (general part) 

 

 

 

BUSHINGS: 

hub_compliance 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 0.0 

fy scaling factor : 0.0 

fz scaling factor : 0.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 0.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/MDI_hub_compliance.bus 

 

subframe_front 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 
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fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

subframe_rear 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

lca_front 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=1.0, 0.0, 0.0 

: xp_vector=0.0, 0.0, -1.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 
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r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

lca_rear 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=1.0, 0.0, 0.0 

: xp_vector=0.0, 0.0, -1.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

lwr_strut 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=1.0, 0.0, 0.0 

: xp_vector=0.0, 0.0, -1.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 
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r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

top_mount 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

uca_front 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=1.0, 0.0, 0.0 

: xp_vector=0.0, 0.0, -1.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 
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t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

uca_rear 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation (dependent) : zp_vector=-1.0, 0.0, 0.0 

: xp_vector=0.0, 0.0, 1.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0004.bus 

 

 

 

NSPRINGS: 

ride_spring 

definition : .ACAR.forces.ac_spring 

symmetry : left/right 

property file : mdids://private/springs.tbl/FRONT_SUSP_600.spr 

value type : 'installed_length' 

user value : 180.7320184693 
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DAMPERS: 

ride_damper 

definition : .ACAR.forces.ac_damper 

symmetry : left/right 

property file : mdids://private/dampers.tbl/FRONT_SUSPENSION_600.dpr 

 

 

 

BUMPSTOPS: 

jounce_stop 

definition : .ACAR.forces.ac_bumpstop 

symmetry : left/right 

property file : mdids://acar_shared/bumpstops.tbl/mdi_0001.bum 

distance type : 'clearance' 

user distance : 200.0 

 

 

 

ADJUSTABLE FORCES: 

camber_adjuster 

definition : .ACAR.forces.ac_aforce 

symmetry : left/right 

pattern : 0,1,1 

desired value : 0.0 

stiffness : 1.00E+06 

damping : 20000.0 

lock : 1 

motion delta : 0.0 

 

toe_adjuster 

definition : .ACAR.forces.ac_aforce 

symmetry : left/right 

pattern : 1,0,1 

desired value : -0.5 

stiffness : 1.00E+06 

damping : 20000.0 

lock : 1 

motion delta : 0.0 

 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

driveline_active single integer 1 

kinematic_flag single integer 0 

hub_compliance_active single integer 0 

hub_compliance_offset single real 0.0 

subframe_active single integer 1 

camber_angle left/right real 0.0 

drive_shaft_offset left/right real 75.0 

toe_angle left/right real 0.0 
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3. S600_Steering 
 

Info for subsystem: S600_Steering 

 

File Name : <private>/subsystems.tbl/S600_Steering.sub 

Template : mdids://private/templates.tbl/_FIAT600_Steering.tpl 

Comments : 

Template : Simple Rack and Pinion Steering System 

Subsystem : *no subsystem comments found* 

Major Role : steering 

Minor Role : front 

 

 

HARDPOINTS: 

hardpoint name symmetry x_value y_value z_value 

-------------- -------- ------- ------- ------- 

input_shaft_forward single 650.0 -154.0 -187.0 

intermediate_shaft_forward single 750.0 -154.0 -87.0 

intermediate_shaft_rearward single 900.0 -154.0 13.0 

steering_wheel_center single 1200.0 -154.0 113.0 

arm_forward left/right 575.0 -179.0 -287.0 

arm_rearward left/right 675.0 -179.0 -287.0 

arm_upper left/right 675.0 -179.0 -187.0 

tierod_inner left/right 500.0 -221.0 -287.0 

 

 

PARTS: 

ball_screw 

symmetry : single 

mass : 0.2773500981 

sprung_percentage : 100.0 

location (dependent) : 632.3223304703, -154.0, -204.6776695297 

orientation (dependent) : zp_vector=0.7071067812, 0.0, 0.7071067812 

: xp_vector=0.7071067812, 0.0, -0.7071067812 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 73.4750121788 , 73.4750121788 , 31.387483477 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

ball_screw link geometry 

name : ball_screw 

symmetry : single 

radius : 15.0 

 

center_link 

symmetry : single 

mass : 3.424590723 

sprung_percentage : 100.0 

location : 300.0, 0.0, -587.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 265.8180179114, -1.5880520905, 300.0 

Ixx, Iyy, Izz : 2.0295542263E+05 , 1541.6943209038 , 2.0422202042E+05 

Ixy, Izx, Iyz : -49.9355526823 , -5.5511151231E-11 , 1.4094628242E-11 

 

center_link link geometry 

name : center_link_middle 

symmetry : single 

radius : 12.7 
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center_link link geometry 

name : center_link_outer 

symmetry : single 

radius : 12.7 

 

center_link link geometry 

name : center_link_right 

symmetry : single 

radius : 12.7 

 

column_housing 

symmetry : single 

mass : 3.3120099232 

sprung_percentage : 100.0 

location (dependent) : 1050.0, -154.0, 63.0 

orientation (dependent) : zp_vector=0.9486832981, 0.0, 0.316227766 

: xp_vector=0.316227766, 0.0, -0.9486832981 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.3421767529E+04 , 1.3421767529E+04 , 1035.0031009926 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

input_shaft 

symmetry : single 

mass : 0.7844645406 

sprung_percentage : 100.0 

location (dependent) : 700.0, -154.0, -137.0 

orientation (dependent) : zp_vector=0.7071067812, 0.0, 0.7071067812 

: xp_vector=0.7071067812, 0.0, -0.7071067812 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1351.8295057462 , 1351.8295057462 , 88.7772096439 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

input_shaft link geometry 

name : input_shaft 

symmetry : single 

radius : 15.0445459276 

 

intermediate_shaft 

symmetry : single 

mass : 1.0 

sprung_percentage : 100.0 

location (dependent) : 825.0, -154.0, -37.0 

orientation (dependent) : zp_vector=0.8320502943, 0.0, 0.5547001962 

: xp_vector=0.5547001962, 0.0, -0.8320502943 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 2764.9179238818 , 2764.9179238818 , 113.1691810841 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

intermediate_shaft link geometry 

name : intermediate_shaft 

symmetry : single 

radius : 15.0445459276 

 

rack 

symmetry : single 

mass : 0.3970225415 

sprung_percentage : 100.0 

location (dependent) : 632.3223304703, -154.0, -204.6776695297 

orientation (dependent) : zp_vector=0.7071067812, 0.0, 0.7071067812 

: xp_vector=0.7071067812, 0.0, -0.7071067812 
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cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 114.8718553432 , 114.8718553432 , 64.3176517244 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

rack link geometry 

name : rack 

symmetry : single 

radius : 18.0 

 

steering_column 

symmetry : single 

mass : 1.7374889711 

sprung_percentage : 100.0 

location (dependent) : 1050.0, -154.0, 63.0 

orientation (dependent) : zp_vector=-0.9486832981, 0.0, -0.316227766 

: xp_vector=-0.316227766, 0.0, 0.9486832981 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.4576457943E+04 , 1.4576457943E+04 , 194.766368528 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

steering_column link geometry 

name : steering_column 

symmetry : single 

radius : 14.9730733795 

 

steering_gear_housing 

symmetry : single 

mass : 1.0 

sprung_percentage : 100.0 

location : 300.0, 0.0, -587.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

steering_wheel 

symmetry : single 

mass : 2.1500262923 

sprung_percentage : 100.0 

location (dependent) : 1200.0, -154.0, 113.0 

orientation (dependent) : zp_vector=-0.9486832981, 0.0, -0.316227766 

: xp_vector=-0.316227766, 0.0, 0.9486832981 

cm_location_from_part : 0.0, 0.0, 0.5768768867 

Ixx, Iyy, Izz : 2.5892147854E+04 , 2.5892147854E+04 , 5.1629176982E+04 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

arm 

symmetry : left/right 

mass : 1.6542605896 

sprung_percentage : 100.0 

location (dependent) : 641.6666666667, -179.0, -253.6666666667 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 16.6666666667, 0.0, 16.6666666667 

Ixx, Iyy, Izz : 3462.459317439 , 4809.9924227329 , 1719.7417379582 

Ixy, Izx, Iyz : 0.0 , 1378.5504913493 , 0.0 

 

arm link geometry 

name : arm 
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symmetry : left/right 

radius : 12.7 

 

arm link geometry 

name : pivot_shaft 

symmetry : left/right 

radius : 12.7 

 

 

 

SWITCH PARTS: 

steering_gear_mount 

symmetry : left/right 

switched to : steering_gear_to_body (mount part) 

part list : steering_gear_to_body (mount part) 

: steering_gear_to_suspension_subframe (mount part) 

 

 

 

GEARS: 

ball_screw_input_shaft_lock 

symmetry : single 

reduction ratio : 1.0 

invert input : no 

 

ball_screw_rack 

symmetry : single 

reduction ratio : 0.4947390006 

invert input : yes 

 

pitman_arm_rack 

symmetry : single 

reduction ratio : 3.09211875E-02 

invert input : yes 

 

steering_wheel_column_lock 

symmetry : single 

reduction ratio : 1.0 

invert input : no 

 

 

 

GENERAL SPLINES: 

steering_assist 

symmetry : single 

type : 'two_dimensional' 

property file : mdids://acar_shared/steering_assists.tbl/mdi_steer_assist.ste 

curve_name : 'steering_assist' 

 

torsion_bar 

symmetry : single 

type : 'two_dimensional' 

property file : mdids://acar_shared/steering_assists.tbl/mdi_steer_assist.ste 

curve_name : 'torsion_bar' 

 

 

 

GENERAL PARAMETERS: 

rack_piston_area 

symmetry : single 
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property file : mdids://acar_shared/steering_assists.tbl/mdi_steer_assist.ste 

data block : 'steering_assist' 

attribute : 'piston_area' 

 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

steering_assist_active single integer 0 

max_rack_displacement single real 50.0 

max_rack_force single real 750.0 

max_steering_angle single real 720.0 

max_steering_torque single real 750.0 

4. S600_Body 
 

Info for subsystem: S600_Body 

 

File Name : <private>/subsystems.tbl/S600_Body.sub 

Template : mdids://private/templates.tbl/_ChasisFinal600.tpl 

Comments : 

Template : Simple One Part Rigid Chassis 

Subsystem : *no subsystem comments found* 

Major Role : body 

Minor Role : any 

 

 

HARDPOINTS: 

hardpoint name symmetry x_value y_value z_value 

-------------- -------- ------- ------- ------- 

chassis_graphics single 0.0 1532.5 1200.0 

path_reference single 0.0 0.0 0.0 

trim_dummy single 1452.643 0.0 356.0795 

bedplate_front_loc left/right 709.5 -680.5 -326.0 

bedplate_rear_loc left/right 1775.2 -682.0 -311.0 

front_wheel_center left/right 283.5 -575.0 -287.0 

rear_wheel_center left/right 2386.5 -580.0 -302.5 

 

 

PARTS: 

chassis 

symmetry : single 

mass : 530.0 

sprung_percentage : 100.0 

sprung_location : any 

location : 0.0, 0.0, 0.0 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 1452.643, 0.0, 6.0795 

Ixx, Iyy, Izz : 1.35818E+08 , 5.31226E+08 , 5.636296042E+08 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

trim_mass 

symmetry : single 

mass : 0.0 

sprung_percentage : 100.0 

location (dependent) : 1452.643, 0.0, 356.0795 
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orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 0.0 , 0.0 , 0.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

aero_drag_active single integer 1 

aero_frontal_area single real 1.80E+06 

air_density single real 1.22E-09 

drag_coefficient single real 0.36 

graphics_choice single integer 1 

 

5. S600_Powertrain 
 

Info for subsystem: S600_Powertrain 

 

File Name : <private>/subsystems.tbl/S600_Powertrain.sub 

Template : mdids://private/templates.tbl/_S600_Powertrain.tpl 

Comments : 

Template : Example of a non-spinning powertrain 

Subsystem : *no subsystem comments found* 

Major Role : powertrain 

Minor Role : any 

 

 

HARDPOINTS: 

hardpoint name symmetry x_value y_value z_value 

-------------- -------- ------- ------- ------- 

graphics_reference single 4036.5 -90.0 147.5 

front_engine_mount left/right 2336.5 -300.0 -152.5 

rear_engine_mount left/right 2936.5 -300.0 -152.5 

 

 

PARTS: 

powertrain 

symmetry : single 

mass : 70.0 

sprung_percentage : 100.0 

sprung_location : any 

location : 2636.5, 0.0, -152.5 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 3.892583E+06 , 3.341916E+06 , 4.079833E+06 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

diff_output 

symmetry : left/right 

mass : 2.0 

sprung_percentage : 100.0 

location (dependent) : 2636.5, -100.0, -152.5 

orientation (dependent) : zp_vector=0.0, -1.0, 0.0 
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: xp_vector=1.0, 0.0, 0.0 

cm_location_from_part : 0.0, 0.0, 0.0 

Ixx, Iyy, Izz : 1.0 , 1.0 , 1.0 

Ixy, Izx, Iyz : 0.0 , 0.0 , 0.0 

 

 

 

SWITCH PARTS: 

engine_mount_option 

symmetry : single 

switched to : engine_to_subframe (mount part) 

part list : engine_to_subframe (mount part) 

: powertrain_to_body (mount part) 

 

 

 

BUSHINGS: 

front_engine_mount 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 

t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

rear_engine_mount 

definition : .ACAR.attachments.ac_bushing 

symmetry : left/right 

orientation : zp_vector=0.0, 0.0, 1.0 

: xp_vector=1.0, 0.0, 0.0 

t preload x : 0.0 

t preload y : 0.0 

t preload z : 0.0 

r preload x : 0.0 

r preload y : 0.0 

r preload z : 0.0 

t offset x : 0.0 
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t offset y : 0.0 

t offset z : 0.0 

r offset x : 0.0 

r offset y : 0.0 

r offset z : 0.0 

fx scaling factor : 1.0 

fy scaling factor : 1.0 

fz scaling factor : 1.0 

tx scaling factor : 1.0 

ty scaling factor : 1.0 

tz scaling factor : 1.0 

tx damping force scale : 1.0 

ty damping force scale : 1.0 

tz damping force scale : 1.0 

rx damping force scale : 1.0 

ry damping force scale : 1.0 

rz damping force scale : 1.0 

property file : mdids://acar_shared/bushings.tbl/mdi_0001.bus 

 

 

 

GENERAL SPLINES: 

capacity_factor 

symmetry : single 

type : 'two_dimensional' 

property file : mdids://acar_shared/torque_converters.tbl/mdi_0001.tcf 

curve_name : 'CAPACITY_FACTOR' 

 

differential 

symmetry : single 

type : 'two_dimensional' 

property file : mdids://acar_shared/differentials.tbl/MDI_viscous.dif 

curve_name : 'DIFFERENTIAL' 

 

engine_torque 

symmetry : single 

type : 'three_dimensional' 

property file : mdids://private/powertrains.tbl/S600_Curva_Motor.pwr 

curve_name : 'ENGINE' 

 

torque_ratio 

symmetry : single 

type : 'two_dimensional' 

property file : mdids://acar_shared/torque_converters.tbl/mdi_0001.tcf 

curve_name : 'TORQUE_RATIO' 

 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

powertrain_type single integer 1 

clutch_capacity single real 1.00E+06 

clutch_close single real 0.25 

clutch_damping single real 10000.0 

clutch_open single real 0.75 

clutch_stiffness single real 1.00E+06 

clutch_tau single real 0.05 

drive_torque_bias_front single real 0.0 
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ems_gain single real 0.005 

ems_max_throttle single real 15.0 

engine_idle_speed single real 1000.0 

engine_inertia single real 10000.0 

engine_rev_limit single real 6500.0 

engine_stall_speed single real 750.0 

final_drive single real 6.5 

gear_downshift_2 single real 1000.0 

gear_downshift_3 single real 1200.0 

gear_downshift_4 single real 1600.0 

gear_downshift_5 single real 2000.0 

gear_downshift_6 single real 2500.0 

gear_ratio_1 single real 3.385 

gear_ratio_2 single real 2.055 

gear_ratio_3 single real 1.333 

gear_ratio_4 single real 0.896 

gear_ratio_5 single real 1.55 

gear_ratio_6 single real 1.0 

gear_ratio_R single real -4.275 

gear_sport_1 single real 7400.0 

gear_sport_2 single real 7200.0 

gear_sport_3 single real 7000.0 

gear_sport_4 single real 6800.0 

gear_sport_5 single real 6500.0 

gear_upshift_1 single real 5400.0 

gear_upshift_2 single real 5200.0 

gear_upshift_3 single real 5000.0 

gear_upshift_4 single real 4800.0 

gear_upshift_5 single real 4500.0 

gear_upshift_thlds single real 60.0,90.0 

graphics_flag single integer 1 

max_engine_power single real 3.10E+08 

max_engine_torque single real 1.21E+06 

max_gears single integer 4 

max_throttle single real 100.0 

min_engine_torque single real -40000.0 

oil_dump_residual single real 0.1 

oil_dump_threshold single real 0.1 

oil_dump_throttle_off single real 1.0 

shift_cycle_time single real 0.5 

sport_flag single integer 1 

torque_tau single real 0.1 

6. S600_REAR_TIRES 
 

Info for subsystem: S600_REAR_TIRES 

 

File Name : <private>/subsystems.tbl/S600_REAR_TIRES.sub 

Template : mdids://private/templates.tbl/_S600_Rear_Tires.tpl 

Comments : *no comments found* 

Major Role : wheel 

Minor Role : rear 

 

 

WHEELS: 

wheel 

symmetry : left/right 

mass : 20.0 

sprung 0.0 
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Ixx, Iyy, Izz : 5.0E+04 , 5.0E+04 , 1.0E+04 

cm offset : 0.0 

whl ctr offset : 0.0 

definition : .ACAR.forces.ac_tire 

high performance: no 

property file : mdids://private/tires.tbl/S600_rear_pac89.tir 

contact type : handling 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

graphics_angle_offset left/right real 0.0 

 

7. S600_FRONT_TIRES 
 

Info for subsystem: S600_FRONT_TIRES 

 

File Name : <private>/subsystems.tbl/S600_FRONT_TIRES.sub 

Template : mdids://private/templates.tbl/_S600_Front_Tires.tpl 

Comments : *no comments found* 

Major Role : wheel 

Minor Role : front 

 

 

WHEELS: 

wheel 

symmetry : left/right 

mass : 20.0 

sprung 0.0 

Ixx, Iyy, Izz : 5.0E+04 , 5.0E+04 , 1.0E+04 

cm offset : 0.0 

whl ctr offset : 0.0 

definition : .ACAR.forces.ac_tire 

high performance: no 

property file : mdids://private/tires.tbl/S600_front_pac89.tir 

contact type : handling 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

graphics_angle_offset left/right real 0.0 

 

8. S600_BrakeSystem 
 

Info for subsystem: S600_BrakeSystem 

 

File Name : <private>/subsystems.tbl/S600_BrakeSystem.sub 

Template : mdids://acar_shared/templates.tbl/_brake_system_4Wdisk.tpl 

Comments : 

Template : 4 Wheel Disk Brake System 

Subsystem : *no subsystem comments found* 
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Major Role : brake_system 

Minor Role : any 

 

 

PARAMETERS: 

parameter name symmetry type value 

-------------- -------- ---- ----- 

kinematic_flag single integer 0 

front_brake_bias single real 0.6 

front_brake_mu single real 0.3 

front_effective_piston_radius single real 75.0 

front_piston_area single real 425.0 

front_rotor_hub_wheel_offset single real 35.0 

front_rotor_hub_width single real 30.0 

front_rotor_width single real -30.0 

max_brake_value single real 100.0 

rear_brake_mu single real 0.3 

rear_effective_piston_radius single real 75.0 

rear_piston_area single real 425.0 

rear_rotor_hub_wheel_offset single real 35.0 

rear_rotor_hub_width single real 30.0 

rear_rotor_width single real -30.0 

 


